Welcome to another issue of Full Circle.

Python makes a triumphant return this month, but still no Blender again this month I'm afraid. If you read last month's issue you'll know that Nicholas is now officially a father and has probably only slept a handful of hours this month. Completing the trinity (with LibreOffice) is an interesting article on managing multiple passwords with a BASH script. Very different!

Inkscape also continues as normal and is joined with the fourth in our series of kernel articles and Charles returns with a second part to his Kodi (formerly known as XBMC) series. Why I remember installing XBMC onto an Xbox. The first Xbox no less! OK, I'm giving away my age. I'll stop now.

Elementary OS is reviewed as is the book (kindly gifted to us by Packt Publishing) Web Development with MongoDB and NodeJS by Jason Krol. Lucas touched upon NodeJS in a previous Command and Conquer article. So, it's only natural that he should review the book. As ever, please support Packt as they're one of the few publishers who send us books for review.

This month brings to an end my current Arduino project, but I'll have something new for you to do next month. Fear not!

Anyway, enough rambling from me. I hope you enjoy the issue.

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org

Full Circle Podcast
Released monthly, each episode covers all the latest Ubuntu news, opinions, reviews, interviews and listener feedback. The Side-Pod is a new addition, it's an extra (irregular) short-form podcast which is intended to be a branch of the main podcast. It's somewhere to put all the general technology and non-Ubuntu stuff that doesn't fit in the main podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

Download
NEWS

Ubuntu Online Summit for Ubuntu 15.04 (Vivid Vervet)

The Ubuntu Online Summit is an event that allows the Ubuntu community to contribute to the development of the operating system by taking part in discussions with the developers. It features a lot of topics regarding the system, some more complex than others, but pretty much all of the aspects of the distribution will be covered.

The current summit is scheduled to take place right after the Ubuntu 15.04 (Vivid Vervet) development cycle has started. Users will be able to find out about the features that are going to be integrated in Ubuntu ahead of time, and they will be able to query the developers about any subject. If you have any questions about Ubuntu (not technical support related), if you want to know why something is implemented in a certain way, or you just want some general information, then the Ubuntu Online Summit is the place to ask them.

Submitted by: Silviu Stahie

Mozilla Releases ‘Firefox Developer Edition’ for Windows, Mac and Linux

The Developer Edition is exactly what it says on the tin: a browser built around the needs of web developers.

The Firefox team set out to bring together tools needed to keep developers productive across a multi-device and multi-platform environment, “creating a focal point to streamline your development workflow.” Though the Firefox Developer Edition has a touch of the familiar, the rejigged UI and features make it a formidable development environment while still the fully capable browser Firefox users know and love.

The biggest change you’ll notice is the dark UI of the slick inspector applied to the rest of the browser. Not your style? You can revert to the familiar light theme by heading into the Customize options at the bottom of the “hamburger” menu and clicking “Use Firefox Developer Edition Theme”.

Submitted by: Sam Tran

Dropbox 2.11.34 Experimental Features a Rewritten UI for Linux Client

Dropbox, a client for an online service that lets you bring all your photos, docs, and videos anywhere, has been promoted to version 2.11.34 for the experimental branch.

The Dropbox developers don’t usually provide too many changes for the Linux platform and the latest update is not all that promising either. In fact, there is nothing specific for Linux, but the branch is an entirely different discussion. This will be a very interesting release when it becomes stable, but until then we can take a closer look at what’s coming.

Submitted by: Silviu Stahie

Canonical Drops Ubuntu 14.10 Dedicated Images for Apple Hardware

Ubuntu 14.10 (Utopic Unicorn) has been available for a couple of weeks and the reception has been positive for the most part, but there is one small piece of
interesting information that didn’t get revealed. It looks like the Ubuntu devs don’t need to build specific images for Apple hardware.

Many Ubuntu users will remember that, until the launch of Ubuntu 14.10, there was an image of the OS available labeled amd64+mac, which was technically aimed at Apple hardware.

The Ubuntu devs marked this interesting evolution in the official announcement for Ubuntu 14.10, but it went largely unnoticed.

Submitted by: Silviu Stahie

Ubuntu Touch Music App Is Proof That Total Ubuntu Convergence Is Getting Closer – Gallery

While other platforms like Windows or iOS are still working towards their convergence goal, Canonical is already there and the developers now have applications that work both on the mobile and on the desktop platform without any major modifications. One such example is the Ubuntu Touch Music App, which looks and feels native on both operating systems.

For now, Canonical is working on Ubuntu for phones and Ubuntu for desktop. Before long, however, the projects will be folded into a single one, probably in a couple of years. Until then, the biggest change that we’re seeing due to this convergence policy is the fact that applications for Ubuntu Touch don’t really have a problem running on the desktop.

The Ubuntu Touch Music App 2.0 is the same as the one you can find on the mobile platform, but there are some perks if you run it on the desktop. Users can resize it and work much more easily with the playlist, which is a nice thing to have. In any case, it only runs on Ubuntu 14.10 (Utopic Unicorn), so that’s the only way to test it.

Submitted by: Silviu Stahie

China starts Windows wipe-out, switches to Linux

China is presently in a situation to completely eradicate Windows from the country. Though this is not immediately possible, the map to wipe-out the Windows operating system from every computer is planned over a period of a few years from now.

According to a report on SoftPedia, China has planned to move away from Microsoft Windows completely. Recently, China had announced the ban of Windows 8 in the country accusing Microsoft of spying the China government and businesses via the operating system.

China has made it mandatory to all organizations to switch from the Microsoft Windows operating system to a locally developed operating system based on Linux.

China believes that by the year 2020, they will successfully eradicate Windows and would have an already switched to a more powerful and secure operating system of their own.

Source: http://www.deccanchronicle.com/41101/technology-latest/article/china-starts-windows-wipe-out-switches-linux
Submitted by: Arnfried Walbrecht

Krita Desktop: A free, open source painting tool, maybe as good as Photoshop

If you do any graphics work you should take a look at Krita Desktop, a really impressive painting tool that rivals Adobe Photoshop for features and makes some ways of working much easier.

Available as free, open source software for Windows (Vista, 7, 8), Linux (Ubuntu, Mint, Debian, and others) and OS X (the site only refers to 10.9 compatibility but I ran it under 10.1.10 without problems). Krita Desktop is also available in two paid-for variants: Krita Studio and Krita Gemini.

First impressions: Way cool,
definitely worth checking out.

Submitted by: Arnfried Walbrecht

**Linux Foundation: Open Source is Eating the Software World**

In every sector of the technology world there is now an open source project that is defining that particular technology. Software drives value in nearly every industry, and open source projects are where most of that value comes from.

That’s according to Jim Zemlin, executive director of the Linux Foundation and one of Monday’s keynote speakers at this week’s OpenStack summit in Paris – the first in Europe. “Open source is really eating the software world,” Zemlin said, adapting the famous phrase from a 2011 Wall Street Journal OpEd by venture capitalist Mark Andreessen, titled Software is eating the world.

Submitted by: Arnfried Walbrecht

**Google Cloud Adds Support for Ubuntu Linux Distribution**

Google partnered with Canonical to bring official Ubuntu images to Google Compute Engine.

Google Compute Engine became generally available in December 2013. Since then, it added support for CoreOS, Debian, Red Hat Enterprise Linux, SUSE and Microsoft Windows Server. Though Debian and Ubuntu distributions are compatible, many developers prefer to work on Ubuntu.

According to Canonical, Ubuntu powers 85% of Linux workloads running on public clouds. Ubuntu is a popular choice of Linux distribution on Amazon EC2, Microsoft Azure and HP Cloud and Joyent.

According to a blog post from Google Cloud Platform team, Canonical maintained images are continually tested and updated, following Ubuntu’s best-practices.

Submitted by: Arnfried Walbrecht

**Ubuntu GNOME 14.10: Unifying the Linux Desktop**

As you may know, Ubuntu 14.10 came out with about as much fanfare as growing grass. If you’re unsure why this happened, it’s simple – Ubuntu is in a state of holding because of Unity 8/Mir. Until that happens, Ubuntu version upgrades will be about bug fixes and not much more. It makes sense... why dump a bunch of time/effort into an interface that’s about to undergo a radical shift? However, that’s not the case for the GNOME flavor of Ubuntu. Ubuntu GNOME 14.10 was released along with the official flavor and brings to light some really impressive features. This release also includes the much anticipated GNOME-Weather – and it’s important to developers, because it comes with numerous new APIs and widgets.

Source: http://www.techrepublic.com/article/ubuntu-gnome-14-10-unifying-the-linux-desktop/
Submitted by: Arnfried Walbrecht

**Canonical Confirms Involvement in Ubuntu Linux Tablet**

According to emails from Andrew Bernstein, who has emerged as the public face of the UT One tablet project, Canonical
"certainly will be involved" in the production of the tablet, which will feature an Intel x86 processor.

For now, Bernstein is holding his cards close with regard to specifying exactly what Canonical's role will be. But he writes that, at a minimum, "we do hope to get official hardware certification and some agreement on support for UT One's software, as in providing support for end users in relation to the hardware."

Bernstein also confirmed that the tablet hardware will be ready to ship by December, although he expressed doubt that the software it needs to run will be available that soon. That's because Canonical likely won't complete work on Ubuntu Touch, the version of Ubuntu that it is building for tablets, phones and other mobile devices, until some time in the new year, postponing the UT One released, Bernstein said.

Source: http://thevarguy.com/ubuntu/110614/canonical-confirms-involvement-ubuntu-linux-tablet
Submitted by: Arnfried Walbrecht

**LINUX STILL OWNS SUPERCOMPUTING**

That's no surprise. For years, Linux has dominated supercomputing. The November 2014 Top 500 supercomputer ranking found 485 out of the world's fastest 500 computers running Linux. That's 97 percent for those of you without a calculator at hand.

Compared to that, Windows on desktops and Android on smartphones are pikers.

Linux has grown to own supercomputing since it first appeared on the Top 500 list in June 1998 because it simply works well in creating ultra-fast computers. Unix, which once dominated the bi-annual listings is down to a mere 13 systems, 2.6 percent. The remaining two supercomputers consists of a system running a mixed operating system and a single Windows system.

Submitted by: Arnfried Walbrecht

**PROMINENT DEVELOPERS PULLING OUT OF DEBIAN AS VOTING DEADLINE NEARS**

Four prominent members of the Debian community have stepped down or reduced their involvement in the project as a result of an increasingly bitter argument over the future of the widely influential Linux distribution.

The battles center on the recent decision by Debian's governing technical committee to replace the venerable sysvinit startup module with systemd in the forthcoming release, dubbed "Jessie." Systemd is a more sophisticated, complex piece of software, which supporters say is a necessary update to a badly outmoded part of Debian, while critics accuse it of being needlessly complex and suffering from serious feature creep.

The criticism has hit a fever pitch in recent months, with systemd creator Lennart Poettering taking to Google Plus to talk about receiving death threats and other online abuse.

Submitted by: Arnfried Walbrecht

**CROWDFUNDING JOLLA, A GNU/LINUX-POWERED HIGH-SPEC TABLET**

It runs an OS called Sailfish that can use Android apps as well its own native apps, and was created by a team with a bunch of senior Nokia refugees on it.

The tablet itself is super high-spec and competitively priced (and total vapourware at this point, caveat emptor). The OS is built on GNU/Linux with the Qt application framework. The company advertises itself as privacy-friendly and promises never to sell or share your data and not to build in any intentional back-doors.

I took a flutter and pre-ordered one.

Source: http://boingboing.net/2014/11/19/crowdfunding-jolla-a-gnulin.html
Submitted by: Arnfried Walbrecht
How the Linux Foundation’s CII Is Securing the Internet

The Heartbleed flaw that was first publicly disclosed in April of this year, was in some respects a black eye on the open-source community. Heartbleed is a flaw in the open-source OpenSSL cryptographic library that had wide ranging impact across the infrastructure of the Internet. In the aftermath of Heartbleed, a new effort emerged called the Core Infrastructure Initiative (CII) to help fund developers wanting to improve security across critical open-source infrastructure technologies. In a video interview with eWEEK, Jim Zemlin, executive director of the Linux Foundation, explains how CII works and what can be done to improve open-source security. Zemlin noted that in the case of OpenSSL, though it plays a critical role in Internet infrastructure, it was not receiving the level of support that is commensurate with the role it plays. There are other open-source efforts beyond just OpenSSL that could also benefit from increased financial support, he added.

Source:
Submitted by: Arnfried Walbrecht

Less' Means More toMalware Authors Targeting Linux Users

Using the “less” Linux command to view the contents of files downloaded from the Internet is a dangerous operation that can lead to remote code execution, according to a security researcher. At first glance, less appears to be a harmless command that outputs a file’s content to a terminal window and allows the users to navigate forward and backward through it. Less does not allow file editing, which is a job for file editors like the widely used vi, but has the benefit of displaying data on the fly without needing to load an entire file into memory. This is useful when dealing with large files. Less is frequently used to view text files, but on many Linux distributions, including Ubuntu and CentOS, it supports many more file types, including archives, images and PDF. That’s because, on these systems, less is extended through a script called lesspipe that relies on different third-party tools to process files with various extensions.

Source:
http://www.pcworld.com/article/2851692/less-means-more-to-malware-authors-targeting-linux-users.html
Submitted by: Arnfried Walbrecht

Antarctic Ice Might Be Thicker Than Previously Thought, Reveals Linux Powered Underwater Robot SeaBED

SeaBED, a submersible robot powered by Linux, was recently used to scan the huge frozen ice sheets across Antarctica. That has helped scientists get detailed and high-resolution 3-D maps of the frozen continent for the first time. Researchers at the British Antarctic Survey will now be able to know more regions which had earlier been difficult to access because of the hostile conditions prevailing in the area.

The robot runs on a 1.2GHz Intel Pentium processor and uses Ubuntu, while the hull of the sub has been so designed that it stays stable enough for photographic work, to allow the sonar to aim precisely and to be able to send the data thus collected consistently.

Source:
Submitted by: Arnfried Walbrecht
Last month I mentioned the Zurb Foundation when discussing bower. For a long while it was my go-to grid system, regardless of my opinion towards using divs for rows and the strict formatting guidelines. Very recently, however, I have found a new framework which does not require those sorts of divs (or even pre-defined classes). It is called Jeet, and after using it on only one project, I don’t see myself using Foundation for the grid any more.

**Example Files**

I’ve created a github repository containing all my example files. For anyone interested in them, they can either be viewed on the web, or cloned. The repository is here: https://github.com/lwest/FCM91.

**Jeet - What is it?**

Jeet is a so-called “Ratio Grid”. It features functions in SASS or Stylus to generate the CSS required to create columns on any element. The website linked to in Further Reading (below) does an excellent job describing what exactly Jeet is. So instead, I will focus on an example of how it differs from Foundation.

**Emmet? Who?**

Emmet is essentially the spiritual successor to Zen Coding. It enables you to enter a series of selectors (based off the CSS selectors), which then auto-completes into HTML code when you hit tab. There are plugins available for the vast majority of text editors, so you should have no problem finding one.

**The Emmet example**

For the illustration between the differences of Jeet and Foundation, I will use the same three statements in Emmet, and work from there. After each statement, I’ll hit tab and have Emmet complete it, then move onto the next. They are:

```html
html:
```

```html
<link href="css/foundation.css" rel="stylesheet" href="css/foundation.css">
```

```html
header+section>article+aside^footer
```

This generates the basic HTML5 page structure (doctype, html tags, head and body).

```html
link[href="css/foundation.css"]
```

```html
This generates a <link rel="stylesheet" href="css/foundation.css"> line. Replace Foundation.css for app.css for the Jeet example
```

```html
header+section>article+aside^footer
```

This creates a set of header tags, followed by (“+” adjacent sibling selector) a section element with two children (“>”, an article and an aside), and then a following (“^” up one level) footer tag.

After running these commands, I will have a basic HTML5 page. To see what the end result was, look in the emmet.html file in the example code.

**The Example**

Assuming you wanted to create a two-column layout that spans the whole width of the webpage, you’d need to do the following for Foundation:

- Create a div with class “row” within the body tags.
- Create an extra style to expand the width of the row to 100%.
- Add your column classes to every element.
- Add a div with class “row” around the article and the aside elements within section.

The same steps for Jeet (starting after the emmet file was created):

- Run the cf() function on header, footer and section (Not strictly necessary, but it definitely doesn’t hurt).
- Run the column function on article and aside (col(0.75) and col(0.25) respectively).
- Compile the scss or stylus file.

In both cases, I’ve added a few extra styles to help illustrate the end layout, but as they aren’t necessary, I haven’t included them.

**Note:** The functions for Jeet can be run in scss, but that requires the format @include col(0.75); The format I use above is for Stylus.
Note #2: If you want to work on the stylus file, you’ll first need to install jeet (most easily done via npm).

The conclusion

As you can see, the configuration of the columns occurs in a stylesheet, meaning you can focus on creating a basic html structure, and then only edit it as you add extra styles that you may need. You’re not forced to adjust the columns by editing the element tags, which is great when you’re working with a CMS and won’t necessarily be able to easily edit an HTML file to make your changes. Another benefit is that the compiled CSS file contains literally only the styles you use. While Foundation does let you pick and choose different modules to compile, there is very often a large amount of unnecessary code.

Hopefully this will help bring Jeet to the attention of those just starting out, so they can focus more on good formatting and being succinct rather than conforming to the Zurb Foundation format. That isn’t to say Foundation isn’t useful for certain aspects, as it offers more than just a grid (such as pre-defined styles for buttons or menus), and it can easily be mixed with the Jeet grid.

Final note: If you want Jeet to work in older versions of Internet Explorer, you’ll need to use something like selectizr, modernizr, or HTML5shiv, or a combination.

I hope this article has been helpful to anyone starting out with web programming. If you have any questions, or have used either Emmet or Jeet for an interesting project, feel free to email me at lswest34+fcm@gmail.com. Also, anyone who has a request for an article is also welcome to email me.

Further reading

http://jeet.gs/ - The Jeet Framework
http://emmet.io/ - The Emmet website
https://github.com/lswest/FCM91 - Github repository with examples.
**CROSS STITCH PATTERN GENERATOR - PART 4 - UNDERSTANDING pyfPDF**

Sorry for missing so many months. I still can’t sit for long periods of time, so this article might be shorter than what you are used to. My original plan was to jump right into the PDF output portion of the program, but there is so much to understand about this library, I decided to use this installment as a tutorial on pyfPDF and then tackle the PDF output next time. So let’s get started.

FPDF stands for Free PDF. A very minimal example would be as follows:

```python
from fpdf import FPDF
pdf = FPDF()
pdf.add_page()
pdf.set_font(‘Arial’, ‘B’, 16)
pdf.cell(40, 10, ‘Hello From Python’) 
pdf.output(‘example1.pdf’, ‘F’)
```

The first line imports the library file. The next creates an instance of the FPDF object. We use the default values for this example, which are:
- Portrait
- Measure Unit = Millimeters.
- Format = A4

If you need to use 'US' standards, you could do it this way:

```python
```

Notice the parameters are FPDF(orientation, units, format):
- Possible values for orientation are “P” for Portrait and “L” for Landscape.
- Possible values for units are: ‘pt’ (points), ‘mm’ (millimeter), ‘cm’ (centimeter), ‘in’ (inches).
- Possible values for format are: ‘A3’, ‘A4’, ‘A5’, ‘Letter’, ‘Legal’ or a tuple containing the width and height expressed in the unit given in the unit parameter.

The third line creates a page to enter data into. Notice a page is not automatically created when we create the instance of the object.

The origin of the page is the upper-left corner, and the current position defaults to 1 cm from the margin. The margin can be changed with the SetMargins function.

Before you can actually print any text, you must call pdf.set_font() to define a font. In the line above, we are defining Arial Bold 16 point. Standard valid fonts are Arial, Times, Courier, Symbol and ZapfDingbats.

Now we can print a cell with the pdf.cell() call. A cell is a rectangular area, possibly framed, which contains some text. Output is at the current position which is specified (40, 10 cm) in the above example. The parameters are:

```python
pdf.cell(Width, Height, text, border, line, align, fill, link)
```

Where:
- Width is length of cell. If 0, width extends to the right margin.
- Height is the height of the cell.
- Text is the string of text you want to print.
- Border is either 0 (no border(default)), 1 is border, or a string of any or all of the following characters: "L","T","B","R"
- Line is where the current position should go after printing the text. Values are 0 (to the right), 1 (to the beginning of the next line, 2 (below). Default is 0, and putting 1 is equivalent to putting 0 and calling ln() immediately after.
- Align allows to center or align the text within the cell. Values are "L" (left), "C" (center), "R" (right).
- Fill sets the background to be painted (true) or transparent (false). Default is false.
- Link is a url or identifier returned by addlink().

Finally, the document is closed and sent to the file with Output. The parameters are fpdf.output(name, dest). If file is not specified, the output will be sent to the browser. Options for destination are “I” (inline to browser(default)), "F" (local file given by name), "D" (to the browser and force a file download with the name passed), and "S" (return the document as a string).
HOWTO - PROGRAM IN PYTHON

Since we will be sending our cross stitch images to the pdf file, we will have to understand the image function.

The function is called like this:

```python
def header(this):
    # Logo - replace with a small png of your own
    this.image('img1.png',10,8,33)
    # Arial bold 15
    this.set_font('Arial','B',15)
    # Move to the right
    this.cell(80)
    # Title
    this.cell(30,10,'Title',1,0,'C')
    # Line break
    this.ln(20)
```

Supported formats are JPEG, PNG, and GIF. If you wish to use GIF files, you must get the GD extension.

For JPEGs, all flavors are allowed:
- gray scale
- true colours (24 bits)
- CMYK (32 bits)

For PNGs, the following are allowed:
- gray scales on at most 8 bits (256 levels)
- indexed colors
- true colors (24 bits)

**Note:** interlacing is not allowed, and if you are using a version of FPDF prior to 1.7, Alpha channel is not supported.

I stole this example (shown right) from the pyFPDF tutorial.

You have been around long enough that you should be able to look at the program and understand what is going on. But in this example the line we are REALLY interested in is the fourth line:

```python
this.image('img1.png',10,8,33)
```

In this instance, we are calling the image function with the filename, the x position of where the picture will go on the page, the y position, and the width of the picture.

Now that you have a gross grasp of the library, we will start our PDF code next time.

Until then, have a good month. See you soon.

---

```python
from fpdf import FPDF

class PDF(FPDF):
    def header(this):
        # Logo - replace with a small png of your own
        this.image('img1.png',10,8,33)
        # Arial bold 15
        this.set_font('Arial','B',15)
        # Move to the right
        this.cell(80)
        # Title
        this.cell(30,10,'Title',1,0,'C')
        # Line break
        this.ln(20)

    # Instantiation of inherited class
    pdf=PDF()
    pdf.alias_nb_pages()
    pdf.add_page()
    pdf.set_font('Times','','',12)
    for i in range(1,41):
        pdf.cell(0,10,'Printing line number '+str(i),0,1)
    pdf.output('example2.pdf','F')
```

---

**Greg Walters** is owner of RainyDay Solutions, LLC, a consulting company in Aurora, Colorado, and has been programming since 1972. He enjoys cooking, hiking, music, and spending time with his family. His website is [www.thedesignatedgeek.net](http://www.thedesignatedgeek.net).
S

preets are good for collecting data like temperatures, stock prices, and sports data. However, the data on its own does us little good. We need ways to analyze the data. LibreOffice Calc provides us with built-in functions to do this. In this article, we will look at a few of the simple statistical functions built into Calc. This is not meant as a thorough examination of all the functions, but more an exercise to get you comfortable using functions.

**Importing the Data**

For our data, I have collected a few months worth of stock prices on the mutual fund FFACX. You can find the data at [http://pastebin.com/AeLcyM1t](http://pastebin.com/AeLcyM1t). The data is laid out as comma-delimited plain text. Copy the data from Pastebin. Make sure that you copy from the “Raw Paste Data” text box. Create a new Calc document. Right-click on cell A1 and select Paste. The Text Import dialog will show. Under Separator Options, select “Separated by” and check Comma. Click OK. You now have two columns of data, the date and the price. Save the sheet.

**Creating a Named Cell Range**

Throughout this article we will use the prices as our data range. Since we will use the range several times, we will name it to make the references easier. Select all the prices (cells B2:B82). The easiest way to select all the cells is to type the range B2:B82 into the cell name box on the formula toolbar and press Enter on the keyboard. Insert > Names > Define, and the “Define Name” dialog shows. Name the range “Prices”. Notice the absolute reference in the Range text box ($Sheet1.$B$2:$B$82). Names apply to a specific group of cells, so the reference is absolute. Under the Scope, we will restrict the use of this name to just Sheet1. Click Add to create the range name.

Now, in any formula or function where we use the name “Prices”, it is the same as typing the cell range $Sheet1.$B$2:$B$82.

**MAX and MIN**

The first two statistical functions we will look at are MAX and MIN. Both functions accept a
list of values or range(s). MAX returns the maximum (or largest) value in the list. MIN does just the opposite, returning the minimum (or smallest) value in the list.

Move your cursor to D4. Type in “Highest.” In the cell E4, type in the formula

=MAX(Prices)

You should get the result 14.16. If you look through the list of prices, you will discover this is the largest number in the list.

In D5 put “Lowest.” The formula for E5 is

=MIN(Prices)

The result is 13.57, the lowest number in the list.

It is also possible to use these, or any Calc function, as an operand in a formula. For example, if we wanted to know the difference between the highest and lowest price, we could use the formula

=MAX(Prices) - MIN(Prices)

in cell E6. In the formula, the results of the functions are calculated first. MAX(Prices) becomes 14.16, and MIN(Prices) becomes 13.57. Then the result of 14.16-13.57 is placed in the cell E6. Place the text “Difference” in the cell D6 as a label.

**AVERAGE, MEDIAN, AND MODE**

In statistics there are many ways to determine just what is the typical value for a set of numbers. Among these are the arithmetic average, the median, and the mode. The arithmetic average, known to most people as simply the average, is the sum of a series of numbers divided by the number of items in the series. In Calc we use the AVERAGE function to get the arithmetic average.

The median ranks the numbers from the lowest to the highest. If the number of items in the series is an odd number, it takes the one in the middle. If it is even, the median is the arithmetic average of the two center numbers. Calc uses the MEDIAN function to calculate the median for you.

Mode is the number that repeats most often. If there is a tie, it uses the smallest number. Calc uses the MODE function to get the mode for you.

We can see the results of these three functions by putting the following formulas in the cells E7, E8, and E9.

=AVVERAGE(Prices)
=MEDIAN(Prices)
=MODE(Prices)

You will notice that the results are within a few hundredths of each others. This is not true in all cases. Numbers that are much larger or much smaller than all the others can affect the average. In those cases, the mode or median might better suit your needs for a typical value.

The Calc statistical functions help us to analyze the data in a Calc spreadsheet. We touched on only a few of the statistical functions. Calc has over 70 statistical functions. This is just one of many categories of functions available to us in Calc. You can get a list of all the Calc functions in the help documentation.

**Conditional Formatting**

In our data set, the top and bottom are pretty close together, so the average will work good for us as the typical value for this data set. We can use conditional formatting to mark each of the prices as either above or below the average.

Start by selecting all the prices in the B column (B2:B82). Since we named the range B2:B82, a quick way to select all the prices is by using the drop down arrow for the cell name box on the formula toolbar and selecting the name “Prices(Sheet1).”

Format > Conditional Formatting > Condition will bring up the Conditional Formatting dialog. Select “Cell value is” from the left drop-down list. From the drop-down list in the center, select “less than.” Enter $E$7 in the text box to the right. If you want to use the median or mode for the
comparison, you can use $E$8 or $E$9. We are using an absolute reference here because we want to reference the same cell regardless of what row we are formatting.

For the Apply Style, select “New Style” from the drop-down list. The Cell Style dialog will open. On the Organizer tab, name the style “Below Average.” Switch to the Background tab and select the Red color swatch. Click OK to close the dialog and save the new style. You will see “Below Average” is now selected as the Apply Style.

Click Add to add a second condition. This time select “greater than” instead of “less than.” Use the same absolute reference, $E$7, $E$8, or $E$9, as you used in the less than condition. Once again select “New Style” for the Apply Style. Give the new style the name “Above Average”, and make the background green instead of red.

OK to save the new style.

OK in the Conditional Formatting dialog will save the settings. Prices that are over the average will highlight in green, and the prices below the average will highlight in red.

**NOTE:** You can create your style for conditional formatting before creating the condition. In such a case, you would just select the style to use.

I hope this article has helped you to understand the use of the statistical functions demonstrated and functions in general. We saw how to use named ranges to identify cell ranges being used repeatedly. We used functions by themselves and as operands in a formula. Using conditional formatting, we highlighted certain cells to show visually the status of the cell’s value. This eliminates the need to scroll back up the sheet to check the average value. Until next month, look up some functions in the help and put them to work for you. Also, play with some of the features of the conditional formatting and see what other visuals you can create.

Next time, I will show you how to validate cell values.

---

**Elmer Perry**'s history of working, and programming, computers involves an Apple ][E, adding some Amiga, a generous helping of DOS and Windows, a dash of Unix, and blend well with Linux and Ubuntu.

He blogs at [http://eeperry.wordpress.com](http://eeperry.wordpress.com)

---

**EXTRA! EXTRA!**

**READ ALL ABOUT IT!**

Our glorious news reporters are now posting regular news updates to the main Full Circle site.

Click the NEWS link, in the site menu at the top of the page, and you’ll see the news headlines.

Alternatively, look on the right side of any page on the site, and you’ll see the five latest news posts.

Feel free to discuss the news items. It’s maybe something that can spill back from the site into the magazine. Enjoy!
I use a Terminal Bash script to interact with my encrypted password files as needed. My script procedure is simple and quick. A person new to Bash scripts should see them as small, self-contained, utility programs which use the full power of Linux and make repetitive, perhaps tedious, difficult tasks much easier to accomplish.

**How I Store My Passwords**

My passwords all reside in encrypted text files on my computer, and also as non-linked, encrypted text files on my website’s hosting server. Here’s my rationale: I am able to easily decrypt any file into clear text when needed on my regular computer whereby I can ...

- Use it on a day-to-day basis, and
- Save it to a USB key in a safe deposit box using clear-text that gets rotated every 15 days—my regular business practice.

(Encrypted files would be quite safe to store even on a cloud storage service.)

**How I Manage My Encryption/Decryption Of My Password Lists**

First, my script runs a quick check to see if the caps lock key is enabled on my keyboard so that I am certain that my master password is correctly typed though it doesn’t display as I type.

Next, control goes through a decryption routine resulting in opening the clear-text file in my choice Linux text editor gedit – where I can read the clear-text file of passwords with accompanying details.

I then close that clear-text file after seeing what I need. The utility then continues and processes the encryption – thereby converting the clear-text file back to its encrypted form and then it saves the result.

Lastly, my script lists the folder of encrypted files (I have many in my actual business), showing the file and its extension as encrypted to verify that the encryption actually was successful with the clear-text file now gone.

Encrypted files get the extension .cpt to indicate encrypted status. All activity regarding encryption/decryption of password files is then logged into the file 'pwlog.' for recording my password file access activity. Note that removing the '.cpt' extension doesn’t undo the encryption.

My script also allows me to navigate to and encrypt or decrypt any chosen file on my computer.

The encryption utility I use is crypt, it’s available from most standard repositories via:

```bash
sudo apt-get install crypt
```

Notes on crypt can be found at: [http://crypt.sourceforge.net/#description](http://crypt.sourceforge.net/#description) which describe fully how to use it.

I chose crypt based of its ease of use and the overall quickness and simplicity of its method. (I firmly believe that most users fail to use encryption because of this.) I’m sure you’d tell me about the advantages of pgp or gpg public/private keys, but I needed something that makes encrypting and decrypting files as dead-simple as possible, and with a reasonable level of security. crypt uses a simpler symmetric key instead.

I imagine that malicious hackers trying to get personal information about me or my files always go for my low hanging fruit on my document tree first, and then maybe even never bother with the delicious higher fruit (where my encrypted files are).

You might appreciate what an encrypted text file using crypt actually looks like. Bring it up with extension .cpt in your text editor; you will quickly realize that decrypting that file using trial and error, anti-encryption software just isn’t a short-time possibility for anyone trying to break your encryption. However, I always assume that NO encryption will...
HOWTO - MULTIPLE PASSWORDS WITH A SCRIPT

Resist persistent breakage forever. Thus, my method is practical without being fool-proof. Remember the low hanging fruit principle.

Make your crypt default password difficult to guess and you’re probably protecting yourself very well. (11+ password characters or more with non-dictionary words, upper/lower case letters, numbers and punctuation)

Example:

mybrother#owEm0E400$

THE SCRIPT

The script resides in my home directory with the terminal command of ./dirpw to start it. My 'pw' folder with password files resides on my Desktop folder 'pw'. In that folder are my encrypted text files: 'customers.cpt' and 'personal.cpt' – that contain relevant webpage control panel login details, e-mail security questions, etc. All activity regarding encryption/decryption of files is also logged into the file 'pwlog.' for recording password-file accesses.

The script presents a directory of 4 choices and an exit option. Entering 1, 2, 3, 4 or 0 sends script control to the relevant selection. I particularly like to use colors in my scripts so that the presented dialog and responses stand out. While I normally heavily comment my scripts, I suspect that most readers will have little trouble following the flow. A run of the script usually clears up the remaining user/coder uncertainties.

Below I’ve included a modification of my Bash script so that you can easily convert it to your computing environment. Make it executable via owner for your computing needs with:

chmod u+x <filename>

Note that I always use indents even in Bash scripts to improve readability and that long lines shown here may display as wrapped around.

SCRIPT

http://goo.gl/ockJEj
Get *unlimited access* to a cutting-edge technology and business library with Apress Access!

For **$199**

**YOU GET:**
- Unlimited access to Apress titles for a full year
- Instant access to each new Apress publication
- Compatibility with any device—desktop, laptop, or mobile
- Use of our new exclusive-to-Apress reader with unparalleled search functions
- Option to download any eBook for just $4.99 for a limited time

[www.apress.com](http://www.apress.com) | [@apress](https://twitter.com/apress)
Want more info? Check out [www.apress.com/subscription](http://www.apress.com/subscription)
After the previous instalment of this series had gone to press, an interesting problem was raised at www.inkscapeforum.com that directly relates to the use of unset fills and clones. So, before moving on to the next topic, I think it’s worth drawing attention to this issue, and how you can deal with it.

Let us suppose that you create a parent object and unset both its fill and stroke. As you know from the previous instalment, you can now set the fill and stroke on any clones independently. I demonstrated using colors, patterns and gradients for both the fill and the stroke, but it seems that one thing I missed was setting a non-opaque color – i.e. one with the alpha (A) channel in the Fill and Stroke dialog set to something other than 255. It turns out that doing this with the stroke works perfectly well, but the opacity of the fill color is completely ignored. In this example you can see what I mean. Both the fill and stroke opacities on the clone have been set to 177, but only the stroke actually appears transparent (the bottom diamond shows how the clone should appear).

It turns out that there’s a bit of a bug in Inkscape (issue 1183400 in Launchpad). When you unset a fill, the program fails to remove the “fill-opacity” attribute in the SVG. Any clones made from that object are then stuck with the opacity that the parent fill had before it was unset. As a demonstration of this, I created a clone and filled it with an opaque green color. Then I set the alpha channel for the green fill to 177. Next I unset the fill altogether. Finally I cloned the object and gave the clone a fully opaque purple color.

What I would expect to see here is that unsetting the fill should also unset the opacity, making it default to the SVG standard of fully opaque. Clearly the parent at the bottom is still translucent, as the blue bar behind it shows. Even without the blue bar, it appears as a washed out gray color, rather than the deep black we would usually expect of an unset fill. Furthermore, the clone is now forced to adopt the transparency of the parent, so there’s no way that any clones of this object could be completely opaque, regardless of their own alpha value.

For most people this bug may never be a problem, but if you do want to set the opacity of your clones to be anything other than 100%, there is a “fix” for the issue. It will mean using Inkscape’s XML Editor dialog, which is a topic I had hoped to avoid until later in this series, but as my hand has been forced, I’ve decided to introduce it now. But to understand the XML editor, you first need a little insight into the structure of an Inkscape file.

The SVG format that Inkscape natively uses is an XML file, meaning that it follows the rules, conventions and structure for such files as defined by the W3C – the standards body of the web. XML is a dubious abbreviation of “eXtensible Markup Language”. In short, it means that every Inkscape file is made up of a hierarchical collection of “tags” (also called “elements” or “nodes”), each of which can carry “attributes” to further define it. For example a simple rectangle might appear in an SVG document as a “rect” tag, with attributes for defining its size and location:

```xml
<rect height="300" width="400" x="50" y="100" />
```
What about the hierarchical aspect I mentioned? How about this more complex example:

```xml
<svg
xmlns="http://www.w3.org/2000/svg">
  <g
    height="300" width="400"
    x="50" y="100" fill="red" />
  <rect id="r1"
    height="500" width="100"
    x="200" y="50" fill="blue" /> 
</g>
</svg>
```

As you can see, we’ve got two rectangles now, and they’ve gained a couple more attributes to set the fill color, and to give each of them an ID so we can identify them individually. Those are both inside a set of `<g>`…</g> tags, which defines a group in SVG terms. The group, in turn, is inside the outermost pair of `<svg>`…</svg> tags. You can think of these as a clue to an application that the content inside them should be rendered as SVG, rather than as HTML or plain text.

Because the “r1” rectangle is first in the file, it’s drawn first on the canvas. The “r2” rectangle is drawn afterwards, so it overlaps the first one. The result is a simple SVG image with a blue rectangle on top of a red one, both inside a group. Try it for yourself: copy the code above into a text editor and save it with an “.svg” extension, then load the file into a web browser or Inkscape.

What if we wanted another rectangle, outside the group? We could just include an additional `<rect>` element but place it after the opening `<svg>` tag but before the opening `<g>` tag. That would put it behind the group when the image is rendered. Place it after the closing `<g>` tag, and before the closing `<svg>` tag, and it will appear on top of the group. Give it a try for yourself, but remember to change the position, size and colour of the new rectangle so that it doesn’t get obscured by the existing ones. While you’re editing the file, how about adding “rx” and “ry” attributes to set the size of the corner radius. Or replace the `<rect>` with a `<circle>`, swapping the dimension and position attributes for “cx”, “cy” and “r” to set the center coordinates and the radius.

By now you should be starting to get a feel for the structure of an SVG document. Of course the ones that Inkscape produces are far more complex, generally including many more elements and attributes, but the basics remain the same. If you want to take a look at some more simple files in your text editor then I recommend the various flag images on Wikipedia, which tend to be pared down and minimised by hand, removing any unnecessary structure or metadata. Examining a few of these will quickly give you some insight into the structure of XML files.

Let’s switch back to Inkscape now, and create a very basic drawing – just a single purple rectangle on the canvas.

With your new found knowledge of SVG you should know how to hand-code this in just three lines, yet, when I saved my copy from Inkscape, the resultant file had 62 lines in! Admittedly many of these were due to it putting every attribute onto its own line – an option that can be set in the SVG Output pane of the Inkscape Preferences dialog. Yet, even enabling the “Inline attributes” setting still resulted in 19 lines. What’s going on?

Look at an Inkscape SVG file in a text editor and you’ll quickly spot a lot of attributes that have a prefix to their names. So rather than label="Layer 1" you’ll see inkscape:label="Layer 1". This is a feature of XML called “namespaces”, and it’s basically a mechanism by which one XML file can safely include elements and attributes from other XML languages without having to worry about them clashing. In this case it indicates that the “label” attribute isn’t part of the SVG spec, but is rather an attribute from the “inkscape” namespace. This allows Inkscape to include application-specific data in a file, whilst still remaining compatible with the SVG
specification, and therefore with other applications that can read SVG files (though they'll usually ignore the Inkscape-specific additions).

In an Inkscape file, you'll typically see "inkscape" and "sodipodi" namespaces that are used to store application-specific data (Inkscape was created as a fork of an older SVG editor called Sodipodi – which was, itself, a fork of an even older vector graphics program). You'll also see "dc" which stands for Dublin Core, and represents the namespace for a set of defined terms used to contain metadata about the file. You can set these using the File > Document Metadata menu item in Inkscape, and it's recommended to fill out at least some of the fields if you plan to distribute your SVG file online. Because the metadata are stored in a standard form using a well known namespace, it increases the chance that your document could one day be indexed by online search engines.

One final thing to note in the file is that the rectangle itself, although it's pure SVG with no namespaced attributes, is a little different to the ones we created earlier. Whereas we used the fill="red" syntax to provide a fill color, Inkscape uses a more general purpose "style" attribute to carry numerous details about the color and style of the rectangle. It also uses hexadecimal RGB numbers for the color, rather than a color name – you can force it to use color names where possible in the Inkscape Preferences, but it's usually not worth bothering with unless you have a specific reason to do so: most colors don't have corresponding names so will still be stored as hex numbers, and using names can cause problems with some Inkscape extensions.

With all that background in place, it's finally time to look at the file in Inkscape's XML editor. You can open this by pressing CTRL-SHIFT-X or by selecting Edit > XML Editor from the menu bar. The dialog is made up primarily of a tree on the left which shows the structure of the SVG file, and a pane on the right to to list and edit the selected item's attributes. The little triangles in the tree can be toggled to show or hide that particular part, and indentation is used to show the hierarchy of the elements. In this screenshot I've expanded all the triangles so that the metadata elements are visible, with their Dublin Core namespace. Despite the closing tags not being explicitly shown, you can nevertheless see that the rect at the bottom is "inside" the group (g) just above it – actually an Inkscape layer, as you can tell from the Inkscape-namespaced "label" attribute. This layer is, in turn, inside the root svg element. One thing to note is that the XML Editor shows the SVG namespace on elements (so you can see svg:svg, svg:g, svg:rect...) even though the exported file just uses the base names (in XML terms the SVG namespace is set as the default for the document, so it doesn't then need to be explicitly added to every element).

When an entry in the tree is highlighted, its attributes are shown on the right. If a single element or group is selected on the canvas it will be automatically selected in the XML Editor, so you can simply leave the dialog open and click on various objects in your drawing to see their details. Equally, selecting an entry in the tree will also select the corresponding object on the canvas.

Here I have the rectangle selected, but there's something odd going on. If you look back at the image of the rectangle on the canvas you'll see that it has dimensions of 400x300 pixels, and is positioned at x=140, y=500. Now look at the XML Editor image: width, height and x are all correct,
but y claims to be 252.36218 – which is pretty far from 500!

SVG places its origin point at the top left of the document. This sort of makes sense, given that it comes from the world of the web where the height and width of a document can change dramatically, but the top left is always the top left. The x-axis therefore runs from left to right, as you might expect, but the y-axis runs from top to bottom, with positive values moving further down the page. Inkscape, on the other hand, presents a more traditional drawing view, with the origin in the bottom left, and the y-axis running up the page from top to bottom. So the 500 value you see in the main Inkscape window represents the distance from the bottom of the page to the bottom of the rectangle, whereas the value in the XML Editor (and the value that appears in the SVG file) is the distance from the top of the page to the top of the rectangle. Usually this incongruity has little impact, but if you’re trying to find specific coordinates in an SVG image you do need to be aware of the difference.

With the rectangle still selected, let’s click on the “style” attribute on the right. The attribute name and value is put into the fields at the bottom of the dialog. In the case of the style attribute, the value is actually a single long string which is, itself, made up of name=value pairs. If you’re familiar with CSS from the web world, then you’ll recognise the format – if not all of the property names (SVG uses a lot of the standard CSS properties you might know from writing HTML, but adds a few of its own). With the style attribute loaded for editing, we can now address that pesky issue with the fill-opacity and clones.

See the “fill-opacity:1;” section, right near the start? We need to remove that. This is just a multiline text field, so simply click to place the cursor in there, then move around with the arrow keys and edit the text as you would normally. Once your editing is done, you need to click on the “Set” button to make it take effect. Assuming the fill-opacity’s value was 1, then you shouldn’t notice any change, since 1 in here corresponds to 255 in the Fill and Stroke dialog, and is the default for SVG if it’s not specified.

Now clone the rectangle, and try changing the clone’s color. You can’t, of course, since the parent rectangle’s fill is still purple, not unset – but, once you give the clone a fill color, you gain access to the alpha slider in the Fill and Stroke dialog. Reduce that value and you’ll see that you can affect the transparency of the fill, if not its color. Select the parent again (SHIFT-D if the clone is still selected) and then unset the fill. Now you can change the clone’s fill color and opacity to your heart’s content. It’s as simple as that: to work around this Inkscape bug, and restore the ability to change a clone’s fill opacity independently of its parent, you just have to remove the fill-opacity property from the parent’s style attribute. Doing this on my original test image gives exactly the result you would expect.

You may have noticed that I haven’t talked about the toolbars in the XML Editor, and that’s with good reason. The buttons there give you the ability to significantly change the structure of your SVG file – potentially with disastrous effects if you’re not sure what you’re doing. By all means have a play around in the XML Editor. Move nodes, un-indent them, change their attributes or remove them altogether. It offers a fascinating insight into the structure of an Inkscape file, and gives you unprecedented power to tweak things that aren’t always exposed in the Inkscape user interface. But if you do decide to experiment, please make sure you do it on a temporary file, or one you’ve got backed up elsewhere.

Mark uses Inkscape to create three webcomics, ‘The Greys’, ‘Monsters, Inked’ and ‘Elvie’, which can all be found at http://www.peppertop.com/
This month we’ll finish our first major Arduino contraption. It’s what I call the laser trip-wire. At the moment, we can arm and disarm the system, and our LDR can detect the loss of the laser. Let’s add to it with another component: the buzzer.

Enter the code to arm it and when the beam is broken the buzzer will sound until either the beam is restored, or the code is entered to disarm it.

But first, we need the buzzer to play something, and this is where we add another library called ‘pitches’. Rather than creating a new file and pasting in stuff, I discovered a new way of adding a library. Click the little down arrow at the top right of the IDE window and choose to create a new tab. Paste your library text in there and voila! You’re done.

I acquired this ‘pitches’ text, and new tab idea, from: http://arduino.cc/en/Tutorial/Tone

I added some code to set things up:

```cpp
const int buzzer = A2; // buzzer is on pin A2
int notes[]={
  // possible notes to play
  NOTE_A4, NOTE_B4, NOTE_C3
};

and:

pinMode (buzzer, OUTPUT); //the buzzer
analogWrite (armedLed, 0); //start as off
```

I also added a new IF statement to check (via the LDR) if the laser is on/off:

```cpp
if (sensorHit < 700 && armed == 1){  //beep when armed & beam broken
  tone(buzzer, notes[3], 200);  //beam broken play note 3
}
```

I found (via the serial window) that the LDR registers about 600 when the LDR is not being hit by the laser. So, in my IF statement and in the main loop, I’m saying: ‘if the system is armed and the LDR is registering less than 700 the laser must be broken so sound tone 3 via the buzzer’.

I also added to the ‘wrong guess’ code:

```cpp
tone(buzzer, notes[1], 200); //boop! wrong code.
```

which just plays tone 1, a ‘boop’ noise, to let you know you got the code wrong.

You could, of course, use a repeating while statement to play several tones to have a more elaborate alarm/jingle.

Are there any similar projects you’d like me to try? Drop me an email at: ronnie@fullcirclemagazine.org.

Remember: I’m a beginner, don’t ask me to design the next NASA rover!

Full code is at: http://pastebin.com/yVeZuAY2

With a demonstration of the system at: https://www.youtube.com/watch?v=efA9lwmE5zA

---

**Ronnie** is the founder and (still!) editor of Full Circle. He’s a part-time arts and crafts sort of guy, and now an Arduino tinkerer.
GUIDELINES

The single rule for an article is that it **must somehow be** linked to Ubuntu or one of the many derivatives of Ubuntu (Kubuntu, Xubuntu, Lubuntu, etc).

RULES

- There is no word limit for articles, but be advised that long articles may be split across several issues.
- For advice, please refer to the **Official Full Circle Style Guide**: [http://url.fullcirclemagazine.org/75 d471](http://url.fullcirclemagazine.org/75 d471)
- Write your article in whichever software you choose, I would recommend LibreOffice, but most importantly - **PLEASE SPELL AND GRAMMAR CHECK IT!**
- In your article, please indicate where you would like a particular image to be placed by indicating the image name in a new paragraph or by embedding the image in the ODT (Open Office) document.
- Images should be JPG, no wider than 800 pixels, and use low compression.
- **Do not** use tables or any type of **bold** or **italic** formatting.

If you are writing a review, please follow these guidelines:

When you are ready to submit your article please email it to: **articles@fullcirclemagazine.org**

TRANSLATIONS

If you would like to translate Full Circle into your native language please send an email to **ronnie@fullcirclemagazine.org** and we will either put you in touch with an existing team, or give you access to the raw text to translate from. With a completed PDF, you will be able to upload your file to the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS

When reviewing games/applications please state clearly:

- title of the game
- who makes the game
- is it free, or a paid download?
- where to get it from (give download/homepage URL)
- is it Linux native, or did you use Wine?
- your marks out of five
- a summary with positive and negative points

HARDWARE

When reviewing hardware please state clearly:

- make and model of the hardware
- what category would you put this hardware into?
- any glitches that you may have had while using the hardware?
- easy to get the hardware working in Linux?
- did you have to use Windows drivers?
- marks out of five
- a summary with positive and negative points

You **don't need** to be an expert to write an article - write about the games, applications and hardware that you use every day.
Access all your data in one de-duplicated location

Configurable multi-platform synchronization

Preserve all historical versions & deleted files

Share folders instantly in web ShareRooms w/ RSS

Retrieve files from any internet-connected device

Comprehensive 'zero-knowledge' data encryption

2 GBs Free / $10 per 100 GBs / Unlimited devices

https://spideroak.com

Online BACKUP Secure SYNC Easy SHARING

Whether you need to access a document you have stored on a remote server, synchronize data between a Mac, Windows or Linux device, share important business documents with your clients, or just rest easy knowing all of your data is safely, securely, and automatically backed up - SpiderOak's free online backup, online sync and online sharing solution can handle all your needs!

SpiderOak offers a different approach to online backup by combining a suite of services into one consolidated tool - free online backup, synchronization, sharing, remote access, and storage. This difference is further measured in our zero-knowledge privacy policy - the first one ever employed in this setting. Our flexible design allows you to handle data from any operating system (Mac, Windows and Linux) or location (external drives, network volumes, USB keys, etc...) using just one centralized account.

Get 25% off any SpiderOak package with the code: FullcirclemagFans

Download mobile clients for iOS & Android

JOIN SPIDEROAK NOW Get 2 Free GBs
In the last part of our series on compiling the Linux kernel for Ubuntu, we - finally! - managed to configure a new kernel. We compiled the kernel itself, as well as the accompanying modules. Finally, we installed all this in the appropriate directories - /lib and /boot - built a new initrd compressed file system, and modified the GRUB configuration to allow us to boot the new kernel.

In this fourth installment of the series, we will be looking into how to make some changes and apply simple tweaks to our kernel, and how they affect system performance. To take a simple example as our guideline, we will be working on a kernel for the original Asus eeePC model 701 from back in 2007. Seven years already – but we can put some new life into this very early predecessor of the netbook fad.

Naturally enough, we will not be doing the compiling on the eeePC itself – since it would take quite a long time to complete. Besides which, due to hard drive size constraints, we would have to import the source and do the compiling on an external drive connected through USB, also incurring a severe speed drop. Instead of this, we will be compiling the kernel on another, more capable, computer, and then transferring the kernel and modules over to the eeePC when finished.

GETTING TO KNOW THE TARGET COMPUTER

The 701 model target computer is one of the first series. As such, it came with a very basic configuration that could handle Microsoft’s Windows XP, or a bespoke variant of the Xandros GNU/Linux distribution. Before breaking out the compiler and actually doing things at the keyboard, let’s take some time to see what exactly the eeePC has under the hood.

Even without cracking it open – which is not recommended – it is a tad complicated to open up, and even worse to put back together again with all the screws in the correct holes! – we can obtain quite a lot of information on the Internet. Some reviews of the time are still available, such as Notebook Review’s of the 4GB eee model “Asus Eee PC 4G Review” (http://www.notebookreview.com/notebookreview/asus-eee-pc-4g-review/), or Marc Spoonauer’s “Asus Eee PC 701 Review” for Laptop Guide (http://www.laptopmag.com/review/laptops/asus-eee-pc-701.aspx). The Ubuntu users' world is also well cared for by help articles on the community wiki (https://help.ubuntu.com/community/EeePC).

Finally, if you have problems getting a recent version of Ubuntu on it and running, my piece called “Install 12.10 onto an EEE PC” in FCM#68 (http://fullcirclemagazine.org/issue-68/) is still fairly current, and should get you going even with a more recent version of your favorite distribution. For example, Linux Mint 17 runs quite well off the SD Card.

The specifications of the original model are as follows: Intel Celeron M 900 MHz processor, 512 MBytes of RAM, 2 or 4 GByte SSD hard disk, 800x480 resolution 7 inch screen, and no optical drive.

Some points need to be made, however. The CPU is actually an under-clocked (at 667 MHz) derivative of the Pentium-III.
LINUX LAB

/proc/cpuinfo reports 630 MHz, no doubt to reduce overheating and extend battery life. /proc/cpuinfo also reports the presence of the PAE extension in the processor on my model, though other users (e.g., our esteemed editor, Ronnie) have reported otherwise. Perhaps slightly different batches of the Mobile Celeron-Ill were sourced during production.

RAM is of the DDR-2 type, clocked at 666MHz. There is space for two RAM slots under the motherboards, though only one of them actually has a slot soldered in. The 512 MByte original RAM can easily be replaced with a 1 GByte PC2-5300 part of the same type, should you have one available.

The hard drive is an SSD model. However, the bus connection with the motherboard is actually a PCI Express module, also soldered in. This means the original hard drive has little chance of getting replaced with something more current. However, the USB 2.0 ports work well with external drives, and the BIOS is quite happy booting either off a USB drive, or off the integrated SD Card reader. An 8 GByte SD memory card makes a fairly cost-effective hard disk replacement that doubles the original capacity, which, with modern versions of GNU/Linux's needs, is no luxury. However, if you do go down this path, please do try to use a class-10 device; inferior cards have slow write rates and will cause your system to slow down noticeably.

Boot-up times with Xubuntu 14.04, or the Linux Mint 17 Mate desktop edition, may be called “leisurely” at best. Once running, a glance at Mate’s system monitor gives us some more information and shows us where some tweaking can take place.

It is clear memory is not much of an issue, with just 252 MBytes in use when the full Mate desktop is running. Since we shall probably not be doing any heavy lifting with this processor and drive (video editing, someone?), the original 512 MByte memory should suffice. 1 GByte, as in this model, is probably overkill.

On the other hand, the processor has the rare characteristic of exhibiting just one core. No dual- or quad-core processor in this one, then. No hyper-threading with virtual cores either. So, if we run into a performance bottleneck, it will probably be here with the CPU. Seeing CPU use go up to 100% during what was effectively some very light web browsing confirms this idea.

CONFIGURING A SPECIAL-PURPOSE KERNEL

We are compiling a kernel for a specific hardware platform, so we are no longer under the constraints that a distribution has to contend with, i.e. handling a maximum number of different hardware setups. This is why our approach can be a tad more radical. On the one hand, we will gut the kernel completely, stripping out whatever we know will not be needed on the target system. On the other, we will make sure we put in any features that can help get the most out of the slightly puny chips inside.

Before starting, let us remind ourselves to compile this 32-bit kernel from within a 32-bit operating system, as noted in the previous part of this series. Although cross-compiling the kernel from a 64-bit platform should work, it actually does not on
LINUX LAB

the Ubuntu 14.04 64-bit version with the 3.13.11.2 version kernel source – the resulting kernel will compile, but will fail to execute on the target machine. This being said, there would be no problem with installing a 32-bit version of Ubuntu on the compile machine (e.g. in a separate partition from the main operating system), even though it contains a more modern 64-bit processor.

We want to make sure we don’t have any little bits of configuration cruft laying around from previous projects, so we issue:

$ make mrproper

Now, let’s get into any of the configuration scripts. I will be using a “make menuconfig”, but, as seen in the previous part of this series, any other configuration script will offer us the same options.

We will start at the top of the main menu, and go progressively down the list. To start out, we need to uncheck the “64-bit kernel” option, since the Pentium-III and this particular Celeron are 32-bit only. This will unlock more 32-bit options further down.

In sub-menu “General setup”, we will not need the “Cross compiler”, “Compile also drivers which will not load”, or “Local version”. As for “Kernel compression mode”, this refers to the vmlinux file compression. It defaults to “Gzip” instead of the more common “Bzip”, which is fine for us since Bzip compressed data a bit more, and so saves some disk space. But it also needs substantially more processing to decompress – and CPU power is what we are lacking on the target. So “Gzip” it is.

We will also configure the “Arbitrary version signature”, putting something significant in its place. Most of the other options in this sub-menu may be left as they are: if at all unsure about a feature, leave it in since parts of the operating system may need it.

I will be deactivating “Support for paging of anonymous memory” a.k.a “swap”, since I have 1 GByte of RAM – and don’t like to use swap anyways. Owners of 512 MByte models would probably do better to leave swap activated.

Lower down, we can configure the initrd file, which we will set up to use only gzip, for the same reason we left vmlinux as a gzip file.

Going back up to the main menu, leave “Enable loadable module support” activated. Although it is theoretically possible to have the complete kernel and all the modules necessary built-in inside a single vmlinux file, this would also mean all drivers would be loaded into memory on boot. This is surely a waste of memory, unless we know very precisely which modules we will need.

We can also leave “Enable the block layer” on, since it is needed to access block devices, such as hard drives.

Now, on to “Processor type and features”. This is where we can do some specific tuning. Contrary to popular wisdom, we will turn off “Symmetric multi-processing support”. This is because we are in a very rare case nowadays, in targeting a processor with no multi-core or virtual cores. So out it goes. We will also turn off “Support for extended (non-PC) x86 platforms”, since the eeePC has a rather typical PC architecture. We will not need the “Intel Low Power Subsystem Support” since we do not have the hardware, nor “Linux guest support” since this kernel is targeted at a physical computer and not a virtual machine. “Memtest” can also go.

We are arriving at the “Processor family” option. Select “Pentium-III/Celeron(Coppermine)”. This way, we get support for the full range of the Pentium-III instruction set, which we would not by using the default kernel from the distribution. Distribution packagers tend to leave this option at “Pentium-MMX”, which is fine since it will work on anything from a Pentium-1 166 or 200 MHz onwards. On a Pentium-III, however, some features that are available in the hardware would not be accessible. If it’s there and available to us, let’s use it: we need all the power available.

Let us leave “Generic x86 support” off, since we are being very specific about the computer we are targeting. Moving on, we can deactivate options such as “Toshiba Laptop support”, “Dell laptop support”, and “CPU microcode loading support” - unless you intend to upgrade your CPU microcode. Most people will
not need this.

The “High Memory Support” sub-menu requires some attention. We will obviously not need the 64 GByte RAM option, that complicates things by introducing the option to compile PAE into the kernel. With a maximum of 1 GByte RAM in our target machine, we can safely leave both the 64 GByte and 4 GByte options, and simply leave High Memory “off”. However, we should be aware that most low-end computer systems share part of their RAM between the motherboard and the graphic card. This means that a computer with 1 GByte RAM will report, within the operating system, the presence of about 993 MBytes of useful space – as seen in the eeePC screen capture above. When switching off “High Memory Support” in the kernel, during execution the kernel will reserve the upper 128 MBytes of RAM for its own use – and so user memory space will find itself quite remarkably reduced to the 863 MBytes seen in the following screen capture: an eeePC running the modified kernel we are now building. Please see the page at the following address for further details:

http://unix.stackexchange.com/questions/4929/what-are-high-memory-and-low-memory-on-linux

Naturally, PAE likewise can stay off.

Of the remaining options in this sub-menu, most can safely be left at their default settings. Just make sure “MTRR support” is on - this feature is part of the Pentium-III instruction set and can accelerate execution - and “EFI runtime service support” is off, since this feature has been introduced only in computers such as Apple's Macintosh, and, more recently, in machines destined for Windows 8.

Back in the main menu, we go down into sub-menu “Power management and ACPI options”. In here, the “Suspend to RAM and standby” option may be deactivated unless we want to sleep our computer. “Power Management Debug” only gives us information in the event of a crash, so off it goes. “CPU Frequency scaling” will also be deactivated because I find our little eeePC is already under-throttled sufficiently for my taste.

Back in the main menu, in sub-menu “Bus options”, the “PCCard” and “RapidIO” options can be switched off.

Moving on in the main menu, in “Networking support” a load of features can be turned off, such as “Amateur Radio”, “CAN bus”, “IrDA”, “Bluetooth”, “WiMAX”, “Plan 9”, “CALF” and “NFC subsystem” - unless, naturally, you wish to use these types of hardware (through a USB dongle?) or software.

In the “Device drivers” section of the main menu likewise, options such as “Parallel port support” can be deactivated. However, I tend to leave much of this stuff in, unless I am reasonably sure I will never need it, as most device drivers are in fact modules that will not be loaded. Module mode “M” is the key here.

In the “File systems” section, much of the same is applicable. Most users will be able to remove support for the “Reiserfs”, “JFS”, “XFS”, “GFS2”, “OCFS2”, “btrfs”, and “NILFS2” file systems, as well as the “CD-ROM/DVD Filesystems”. In the “DOS/FAT/NT Filesystems”, “VFAT” may sometimes come in useful if you are planning on using an external USB thumb-drive in this format.

“Kernel hacking” is perhaps best left alone: most of the stuff in here is mostly useful to debug a kernel during development. In “Security options”, I personally do not use SELinux, and deactivate the “NSA SELinux” option. Likewise for “Tomoyo Linux Support”, “AppArmor”, “Yama” and “Integrity Measurement Architecture”. These are tools destined for specific situations that the average desktop user will probably not find himself in.

Back in the main menu, nothing needs to be configured in the “Cryptographic API”. As for drivers, it is best if in doubt to leave stuff in that the kernel or other libraries
may need, if only to verify apt package signatures. In "Virtualization", however, we can deactivate everything since our system will be neither host nor client for kernel-level virtualization. I would also leave "Library routines" at their default values.

**COMPILING, TESTING AND INSTALLING**

Once we have all the kernel options set up, we save the configuration with the default file name "config", and proceed to compile it:

```
$ make
```

Some time later - though a tad less than when compiling the kernel with the default configuration - the system reports that all has gone well. Now, we will begin by installing our new kernel on the same computer we compiled it on. This is because if something were to go wrong, it is easier to test it out and recompile if necessary before transferring the kernel to the eeePC. So we go into administrator mode, and perform installation:

```
$ sudo bash
# make modules_install
# make install

  If all goes well, reboot the computer, and test the new kernel. If the machine you are compiling on has a newer processor than the Celeron, all should go well. If you got a kernel error at boot up, e.g. a kernel panic because something was missing, read carefully the error message. If at a loss, Google can give some insight on what has happened – you will surely not be the first one to encounter such a problem. Then reboot the computer and, in the GRUB menu, select “Advanced options for Ubuntu” (or similar), and reboot using the previous kernel.

  In some cases, the kernel will start up well, and then crash on the following error:

Starting init: /bin/sh exists but couldn't execute it (error -8)

  This is usually due to the computer running out of memory when the kernel itself has been loaded, but the initrd compressed file cannot be loaded for some reason. Possible causes can include a hard drive with a GUID partition table, simply running low on RAM, since 512 MBytes is considered extremely low for a modern system.

  Another possibility is having a bloated initrd file. This latter does happen with the Ubuntu system and kernel source, and is easy to detect by executing

```
ls -lh /boot
```

  You should see the original initrd.img file weighing in at about 19 MBytes (specifically version 3.13.0-24-generic). If the initrd.img file you have generated goes way up into the 100 MByte mark, you have run into initrd bloating. This is due to the fact that, during compilation, a host of debugging symbols have been retained within the kernel and library executable code. The interested reader can see more about this at the following address:

http://unix.stackexchange.com/questions/30345/why-is-my-initial-ramdisk-so-big

  The solution proposed in this reference is to explicitly tell the compiler to strip out debugging symbols. The following commands have given me good results. Initial compilation:

```
$ make INSTALL_MOD_STRIP=1
```

and kernel installation:

```
$ sudo bash
# make INSTALL_MOD_STRIP=1 modules_install
# make INSTALL_MOD_STRIP=1 install
```

  The resulting kernel vmlinuz file should be about 10-15% smaller than the original. The initrd compressed file system should weigh 16 MBytes or less, depending on the modules that have been deactivated.

  When running the new kernel on the computer used to compile it, it may be interesting to run system monitor. In the next screen capture, a Core i5 is running the new kernel. We may note that RAM is given as 863 MBytes, when the machine actually holds a full 4 GByte complement. This is because we turned High Memory off during compilation. In the same way, since we turned multiprocessing off, the next monitor tab reports the presence of a single CPU kernel,
and not the four reported by regular kernels. As a side note, we can see the new kernel compiled from the Ubuntu 14.04 distribution mixes well with a previously installed Linux Mint 17.

Finally, we need to install the new kernel on the eeePC. In my case, I simplified things by not using the eeePC's internal drive. Instead, I am using an 8 GByte SD Card as the main hard drive, so it was merely a question of inserting this drive into the computer I compiled the kernel on, and copying the files over. With the SD card inserted and in administrator mode, suppose the new kernel has version number 3.13.11.2:

```
$ sudo bash
# grub-update
```

That's it, from now the GRUB menu's default boot option should be the new kernel and initrd. As discussed previously, the second option should still grant you access to the original kernel installed by the distribution, so with a bit of luck you should not end up locked out of your own computer (one hopes).

When testing out the new kernel, for example browsing some slightly complex web pages with Javascript and active images running, the processor should not get pegged at 100% capacity quite as often. A slight, but noticeable gain in speed should be apparent in general system operation. As a supplementary benefit, the processor is now using the more complete instruction set for the Pentium-III. The supplementary instructions contain some parallelism built in, so the CPU needs to execute less instructions to complete any given task, resulting in less heat generation and perhaps even a tad more battery life. However, YMMV (Your Mileage May Vary), and you will need to check this out for your own specific work-flow.

Once the new kernel is installed and working from the SD-Card or, perhaps, an external USB drive, to install it on the eeePC's internal 4 GByte hard drive is also just a matter of copying over the files in boot (vmlinuz, initrd, System.map), and the complete library directory in /lib/modules, and then updating GRUB on the target system once rebooted.

In this part we went through a specific case of kernel compilation, designed to actually implement the configuration, compilation and installation discussed in part three of this series. The eeePC is a small, lightweight notebook that still holds its fascination for some of us, besides being actually useful from time to time. It's external shell is really tough, compared to some more modern offerings, which can always help if we should need to use a mobile computer on the go.

In the next episode, we will see how to start hacking the kernel code itself, making small changes in the source code and seeing what comes out of it.

---

Alan teaches computer science at Escola Andorrana de Batxillerat (high-school). He has previously given GNU/Linux courses at the University of Andorra and GNU/Linux systems administration at the Open University of Catalunya (UOC).
Kodi/XBMC entertainment center is a pretty incredible piece of software. Not only is it available for Linux, but also Windows, OS X, Android, iOS (on Apple TV), and for hardware like the Raspberry Pi and Android phones and tablets. Release 13.2 is the last release to use the name XBMC; future releases will all be known as Kodi, in part because XBMC has never worked on newer XBox machines, and because Kodi has evolved to more than just a media center. For this article, we’ll refer to the old name, XBMC, since Kodi doesn’t have an official release yet.

XBMC can play most music file formats: flac, mp3, wav, wma, and a host of video file formats. XBMC can also stream. Take the scenario where someone wants to watch television (where your XBMC system is hooked up to) and you want to watch a movie stored on the system, you can just grab your tablet or phone and have XBMC stream to the tablet. Having family over you haven’t seen in awhile? With XBMC you can create a slideshow of all your old family photographs and have music playing in the background – the trick is to start playing the music first, then hit the pictures button on your remote, find your photographs, and press the play button on the remote to start your slideshow. Much of XBMC’s flexibility comes from the plethora of add-ons available for it – that range from lyric downloading add-ons to add-ons that show internet streaming video (Twitch.tv and Youtube for example). If you know how to set up a PVR back-end like Myth TV, NextPVR or TVhead, you can even use XBMC as a front-end to record and watch your favourite television shows (a tv tuner card is required for this functionality).

For our home entertainment system, we’ve used XBMC on an atom-based netbook, an Android-based PIVOS XIOS DS Media play box, and a full-fledged Linux PC. The last option has served our family best because of the flexibility. Both the XIOS DS and the netbook were nice because of the size, but we needed to attach our drives via USB and that required more power outlets. We could have built a separate NAS box elsewhere, but again it’s a whole other box, it was simpler just to build XBMC in one box with multiple drives.

Our netbook was fine for standard definition video, but it struggled with high definition video. For HD you’ll want a dual-core system. Our system has an Intel Core 2 Quad Q8300 processor that handles all video beautifully at 1920x1080. On the software side, we used xbmc.org’s Linux distribution + XBMC, better known as XBMCbuntu to install.

Installing XBMCbuntu is fairly straightforward. If you’ve installed any form of Ubuntu, the installation process is exactly the same. Installation can be a bit tricky if your machine is connected to your television and you’re using a DVI or HDMI cable. XBMCbuntu sometimes fails to detect the proper EDID (Extended Display Identification Data) which causes distortions (in our case tiny text and a stretched interface). If you know all the steps in the Ubuntu install, you can actually type through the EDID problems, and XBMC will eventually load nicely, but if you ever fall back to the window manager it will appear distorted.

We use an NVidia GeForce 210 card that has VGA (DSUB), DVI and HDMI, so installing with a readable interface was simply a matter of connecting the VGA cable to our TV (which also has VGA). If you want to use the fallback window manager, have a look at the Ubuntu manpages for get-edid, and read-edid: http://manpages.ubuntu.com/man pages/lucid/man1/get-edid.1.html.

Oddly enough, stock Xubuntu seems to detect our television just fine over HDMI, the problem seems to be restricted to using XBMCbuntu. If you choose to start with stock Ubuntu/Xbuntu/variant, you’ll need to do more work configuring your remote using LIRC, installing video drivers, and setting up SSH to name a few
details XBMCbuntu takes care of.

Perhaps the simplest way to cover major features of XBMC is to step through the main menus in the default theme (Confluence) menu. The menu options in Confluence are Weather, Pictures, Videos, Music, Programs, and System. Movies and TV Shows menu options appear once you’ve added a movie or TV show directory through the Videos menu. Different themes (available through the System > Settings menu) will display different menu options. Some themes add other functions. Most of the menu choices also have sub-choices. Videos has a sub-menu of Files, Library and Add-ons, for example. XBMC provides a first run help when you first click in these menu options.

The Weather menu doesn’t display weather until configured through an add-on. The simplest way to set-up weather is to click System > Add-ons > Get-Add-ons > XBMC.org Add-ons > Weather, and choose from the Met Office (UK), Oz Weather (Australia), Weather China, Weather Underground, World Weather Online, or Yahoo! Weather. Weather Underground recently got marked as broken in the repository, and World Weather Online is incompatible with XBMC 13.x. For Canada/US, Yahoo! Weather currently works well. Once you install the add-on, you’ll need to configure it. Click on the name of the add-on you chose (Yahoo! Weather in our example) then click Configure. You can set up to 3 Locations. To set up a location, click on one of the three: Location 1, Location 2 or Location 3 choices, and enter your location or a major city near you. Weather now should display if you click on the Weather menu option.

By default, XBMC displays the current temperature, whether it’s sunny, cloudy, rainy, etc., what the temperature actually feels like (it might be 7 degrees Celsius and feel like 2 degrees), the humidity, uv index, and where and how fast the wind is coming from. The Yahoo! Weather add-on also displays a week of weather on the right side of the current temperature. To change to another location, click the left arrow button on your remote control (or the left arrow on the left side of the screen). The View options for the weather menu appear on the left side. From the options, you can cycle between the cities you chose to set up, refresh the weather, change the settings (location on the Yahoo! Weather add-on, weather maps on other plug-ins), hide the fan art displayed beside the temperature or set the path for the fan art.

Earlier, I mentioned the temperature in Celsius, but the default XBMC setup was originally in Fahrenheit. To change to Celsius, we needed to click Settings > Appearance > International, and change the Region option which (was set to US) to Canada (or whatever country you live in).

Clicking on the Pictures menu brings up Picture Add-ons, Pictures, and Add-Pictures options. We copy pictures using SSH but XBMCbuntu is set up to be a SAMBA machine so Windows machines on your network can drag and drop files to a folder that you can add as a picture source. We organize our photographs into directories by event. Like the weather menu, you can change various picture options by clicking on the left arrow on your remote or on the left side of the Pictures display. Options include View, a couple of sorting options, filters, slideshow options and randomize. You’ll see the view option on several of the menus (movies, television shows and music). Changing the view allows you to
change how the pictures or directories are shown on the screen. By default, Confluence displays pictures in a list-view which shows files and directories on the left side and a few thumbnails on the right side. Switching to big list only displays the file/directory names. Thumbnail view displays a box of 4 thumbnails for each directory or simply thumbnails for the pictures. The Pic Thumbs view splits the screen again and displays a thumbnail on one side and a larger version of the picture on the other. Image wrap displays the thumbnails across the bottom and a larger picture in the middle of the screen. Many of these view options also appear in the movie, tv show, and music menus. To display a slideshow of pictures, use the arrow buttons to navigate over a picture and hit the play button on your remote. If you’re using a mouse, use the slideshow option in the view menu.

From the videos menu, you can add movies and tv shows. Adding movies or tv shows is almost the same process. Click Videos > Files > Add Videos. You will be prompted to Add video source. If you know the path where your movies or television shows are, you can enter it into the field that says <None> or click the Browse button to browse through your directories until you find the directory with your media content. Once you’ve finished adding the path to your media, give it a name, for example: Anime or Old Movies. Next, you set the type of content; the choices are: None, Music videos, TV Shows, and Movies. For Anime, use the TV Shows scraper. Click OK when done.

A scraper is a program that “scrapes” a website for information. In the example above, XBMC scrapes The TVDB website for information about our Anime shows (to scrape Anime set the media as TV Shows). XBMC will then ask if you want to refresh the info for all the items. Depending on how many items you have, this could take anywhere from a few seconds to several minutes. XBMC has a choice of scrapers for each type of media.

We use the Video add-ons almost as much as we do the movies and tv shows menus. Lots of great add-ons exist to watch content like TED Talks, Revision 3, Twitch.tv, sports, NASA content, music videos, trailers of upcoming movies, or the infinitely exciting VIMcasts (learn VIM). I mock VIMcasts, but there are some very cool shows like VIMcasts to teach coding. Before you can watch an add-on, you have to get it. To get add-ons, first go through the System > Add-ons menu and click Get Add-ons. XBMC comes with a handful of add-ons, but you can add more add-on repositories, just as you would a Linux distribution (for more software). There are lots of youtube videos covering adding other repositories to XBMC so we’ll skip that here.

Clicking on the movies menu brings up the list-view of movies (if you have any installed). In list-view, pressing the right arrow on your remote will bring up the view menu. If you change the view to the Poster Wrap view – which scrolls DVD cover art right and left – you need to press the up arrow on the remote to bring the view options menu up. Default views in movies are: List, Big List, Thumbnail, Poster Wrap, Fan Art, Media Info, Media Info 2, and Media Info 3. The Fan Art and Media Info views display the most information about movies, while Thumbnails and Poster Wrap display only images. If you have a remote control with the Guide button, you can press Guide while on top of a movie to bring up movie options: Queue item, Play from here, Add to Favourites, Movie information, Mark as watched, or Manage. We use the Queue item from time to time to play movies and their sequels.

The TV Shows menu is similar to the Movies menu, but includes a Wide view that displays art in a banner ad format. Like the movies options, you can sort a number of ways, filter content, hide watched shows, search for a show, update the library of shows, or show the current playlist.

Movies, music videos, and television shows all need to be named a certain way for the content scrapers to correctly figure out the show. For example, it’s important to discern whether you’re watching the first show of the first season of Dr. Who, or the ninth season. The Kodi/XBMC wiki is the best reference for naming videos:

http://kodi.wiki/view/Naming_video_files
Music is different from video because you must have proper id3 tags for XBMC to correctly parse the music. Easytag is a popular GTK+ id3 tag editor. On the KDE side there’s kid3.

Easytag: https://wiki.gnome.org/Apps/EasyTAG
Kid3: http://kid3.sourceforge.net/

The Music menu also has a lot more options: Genres, Artists, Albums, Singles, Songs, Years, Top 100, Recently added albums, Recently played albums, Compilations, Playlists, Search, and Music Add-ons.

When you’re looking at the music library, you can bring up the view options by clicking on the arrow on the left side of the screen or using the left arrow on the remote control. The music view has a couple of options not present in other media types: Library mode or Party mode. Library mode is as it sounds, a listing of your music library. Selecting Party mode starts playing a random selection of your collection with both album and background art. We also have the CU LRC Lyrics plug-in installed so lyrics are also displayed.

To add a music add-on, navigate to the music menu option; files and add-ons appear below the menu. Either click on the music menu and then click Music Add-ons, or just click the add-ons sub-menu option that appears below the music menu option. Click Get Add-ons to pick from the stock add-ons. Some of the default add-ons that caught our eye were the Apple iTunes Podcasts (you don’t need an iTunes account to play them), Grooveshark XBMC, High Voltage SID collection (currently broken, but cool if you like playing tunes from the Commodore 64 era), Internet Archive, JamBMC (Jamendo radio), NPR (National Public Radio), Pandora radio, Shoutcast 2, Soundcloud and TWiT. There are more add-ons, and you can add even more by adding other XBMC add-on repositories through the System menu.

The Programs menu is empty until you add some add-ons. In our house, we use the Artwork Downloader add-on which downloads extra artwork for television shows and movies, Movie Quiz – a fun quiz that goes through your movie collection and asks questions based on your collection, TV Tunes – which fetches the theme songs for your television content and plays the theme when you browse the show seasons or files, and XBMC Library Auto Update – which automatically updates your music/tv show/music video/movie libraries.

There are lots of other interesting add-ons in the stock add-ons including add-ons to display Facebook media, an XBMC Forum browser to show the XBMC forums in XBMC, a GMail checker, ircChat, Linphone support, a ROM collection browser for those who love retro gaming, a plugin for Sonos owners, a plug-in for bittorrenting using Transmission, and a PBX plugin for Asterisk.

The System menu is where a lot of other XBMC magic occurs, from enabling repositories, getting add-ons, setting up locales, to SAMBA setup, enabling other forms of remote control, getting and enabling new skins, to multi-profile setup.

The System sub-menu – the menu below the System menu text on the main XBMC screen – differs from the menu you get when you click on System. Clicking on System brings up System > Settings which is actually one of the sub-menus
options. The File manager sub-menu settings are used for browsing the file system and adding repository shortcuts. Profiles allows you to set up XBMC so different users have different set-ups. Typically, people use this to restrict access to adult content, but it can also be useful if you want to present someone with a simpler interface (theme) and set of add-ons that’s more consistent with their likes. The System info sub-menu brings up another menu of useful information divided by hardware type, including a summary, storage information, network information, video information, hardware information (CPUs and RAM), and, if you have PVR (Personal Video Recorder - think MythTV) functionality set-up, information about the PVR service. From time to time, we refer to the network information if we're having an issue with our network. Storage is also handy for when you think you're approaching the end of a drive.

The System menu actually brings up the majority of the settings for XBMC, and there are a lot of settings that go multiple levels deep. XBMC is huge, so, to keep it brief, we'll just touch on the settings options and some of the ones we use. The main System settings are Appearance, Video, Live TV, Music, Pictures, Weather, Add-ons, Services, and System. Clicking on Appearance brings up a new menu full of options that allow you to control anything from font size zooming to whether hidden files and directories are shown. We already touched on the International menu in order to change from Fahrenheit to Celsius. The Skin menu is the menu most people are interested in checking out. Clicking Skin, then right-navigating and clicking on Skin > Confluence > Get More lets you get more XBMC themes. Skins can dramatically change the look and some of the functionality of XBMC, this includes the main menu that's displayed on startup. When we change to Ace, for example, the main menu options become Movies, TV Shows, Concerts, Music, Favourites, Games, Images, Weather, Settings, and Exit. While some of the menus are simply other names for the same thing, other options like Favourites would have been buried in a sub-menu under Confluence. Themes can also change how content is displayed (the view). Some themes add more information to the view than others. Pay attention when changing themes, it can be tricky to navigate your way back to change the theme to something else. Under the Ace theme, the System menu is sensibly called Settings. If changing the theme wasn't enough for you, you can control each theme's settings from System > Appearance, and, on the Skin tab, navigating to the Settings option under the Skin name. The Skin settings brings up yet another sub-menu of options to control the skin, We use the Add-on Shortcuts tab to show our favourite add-ons on the home screen below the menu names.

System > Video brings up another entire sub-menu of options. Worth looking at are the Acceleration tab to ensure you're using your video card's acceleration features, and the Subtitles tab which lets you set things like the location of sub-titles (both on the screen and the path subtitles are stored when they're downloaded) as well as the size, style and font.

System > Live TV has a bunch of options for controlling PVR functionality. Look here if you want to control your TV Tuner card from within XBMC. We don't use this functionality in XBMC, but it exists and is worth mentioning for those who do.

System > Music displays a sub-menu for controlling your music media collection. If you don't like how XBMC wants music named, you can change how tracks should be named. You can change the default action when audio CDs are inserted into your XBMC system (the default action is to rip an audio CD, encode it with lame, and eject the CD when done). You can also change which visualization (OpenGL Spectrum) is displayed by default when you start playing music. There are a lot of options to explore right down to crossfading and karaoke support.

System > Pictures displays a mercilessly small set of menu options, but even this sub-menu has about 7 different options – that range from panning and zooming during slideshow playback to whether video files are shown in picture listings or not.

The System > Weather menu is even sparser showing only a couple of settings, the weather service to use and the settings for that
LINUX LAB

weather service. It’s sparse perhaps only because some of the options that would be helpful here (the International menu for choosing country and getting Celsius / Fahrenheit) are elsewhere in XBMC.

We touched on the System > Add-ons menu. System > Add-ons extends XBMC by allowing you to get Add-ons from different repositories to extend the functionality of XBMC. There are a lot of Youtube videos about how to add various add-ons but a warning is perhaps necessary here; be sure to back up your XBMC settings. Using repositories and add-ons other than those sanctioned by XBMC can really mess up XBMC to the point where it’s simpler just to rm -rf ~/.xbmc/ and start from scratch.

System > Services contains the options for controlling XBMC via UPnP (Universal Plug and Play), via http (used by software remotes like those on some Android applications) as well as Apple AirPlay and SAMBA options.

Finally the System > Settings menu is useful for adjusting sound and video options. If you had problems displaying EDID and used a VGA cable to set up XBMC, and then switched to HDMI, you can often switch the resolution by selecting System > Settings > Video Output > Resolution. If audio isn’t working right, check the Audio output tab on this menu. From time to time, we’ve used the Internet access tab to set a proxy just for XBMC.

We’ve covered all the main menu options for XBMC, and yet we’ve really only barely scratched the surface of what XBMC is capable of. XBMC is one of those programs that the more you dig, the more options you find, and friends are doing some pretty amazing things with some of the XBMC plug-ins and other software: Flexget and the Transmission web front-end plug-in for example.

XBMC is one of those programs that’s YMMV, Your Mileage May Vary, depending on the effort you put in to customizing it the way you like it. We find it’s pretty amazing.

Useful links:
Kodi/XBMC keyboard controls: http://kodi.wiki/view/Keyboard_controls
Kodi/XBMC - http://xbmc.org - will likely change in the future
FLAT 20% Discount

Offer Valid till - 21st November 2014

Use Discount Code - gUdb4pzLI

HTTP://BIT.LY/1rG1QDE
In FCM#90, Arnfried Walbrecht submitted a link to a review of the “Elementary” OS. This sparked my interest as I had been wanting to test this distro for some time but releases are few and far between. The UK reviewer summed it up as “my top pick these days for Linux newbies”.

I liked the fact that the download was small compared with many ISO’s, less than 1GB. I created a bootable 8 GB USB stick with no problem. I went straight to the full install and this was using the standard Ubuntu install program so no problems there; it completed within 30 minutes. I then used update manager which brought the whole system up to date as at 1st November 2014.

Elementary booted up fast to an attractive login screen with a limited number of pre-installed applications. I like this as the user can then install their favorites from the Ubuntu repositories. The desktop is very clean and responsive and

the only bug I found is that the date disappeared from the top panel and there is no way to re-install it; remember it is a beta release. The dock at the bottom shows some static items and any open windows. You can right click any icon and elect to pin it to the dock permanently, or remove it. My only gripe with this is that you cannot recognize whether the icon represents a launcher or an open window. Also I prefer my icons in the top panel to save real estate but that is a personal preference.

The initial applications supplied are a mixed bag. Many of them are unique to Elementary and use the brand Name “Pantheon”. The Calculator, Calendar, Screenshot, Simple Scan and Snap are quite standard and Evince is supplied for reading PDF files. Gnome Font Viewer works as expected but it is a strange choice when supplying a basic install; it can hardly be considered essential.

Pantheon Photo is a fork of Shotwell which is my favorite photo library so no complaints from me. It appears to be a re-branding as there are no obvious changes.

Pantheon Music worked well with my .flac files with the usual playlist functions.

Pantheon Video was a different story. It provided sound only for FLV files, and the video for MP4 files only appeared if I hovered the mouse over the timeline.

The Pantheon File Manager was a disappointment as there are no configuration options. You cannot select which columns to view or set default list/icon views. Worse, you cannot drag and drop files to another folder or to a text editor. You cannot create bookmarks and right-click options are very limited. It is very basic indeed but, hopefully, a work-in-progress.
Pantheon terminal worked as expected and allowed multi tabs but it was gray text on a black background with black borders. There were no options to configure this. I installed “RxTerm”.

The text editor supplied is “Scratch” which is adequate but if you select “line wrapping” it will break lines in the middle of a word; very odd.

Email is handled by “Geary” which would not allow me to register a POP3 account. I could create accounts with Gmail or Hotmail but if you select “Other” and enter your email address then the “Next” button is disabled. Maybe it would work with an IMAP address.

“Midori” is supplied as the default browser but this has a problem with Adobe Flash. Sites which require this will report that it is not installed but, if I try to install via Software Center, it is shown as being installed. I installed Firefox and it worked fine with the same sites.

The Pantheon applications are linked to the desktop. They do not have an “About” menu but you can access this facility by right-clicking the menu icon. It is impossible to uninstall them. In software Manager they are listed as options under the main desktop install. I unchecked the options and clicked “Update” but they were still there.

The window manager does not follow the common convention of putting “Minimize”, “Maximize and “Close” icons the top right corner of windows. “Close” is in the top left corner, “Maximize” is in the top right corner and “Minimize” is missing completely.

The Ubuntu “System Settings” is supplied with many items removed; there were only 19 items compared with 31 in Mint LMDE. This highlights the fact that there is very little customization allowed. This is a matter of personal choice, but I would like the ability to change the color of the panel and add or remove applets. There are no themes available, but a selection of wallpapers is supplied. My biggest problem was to add another language – but I suspect this is a Ubuntu problem not unique to Elementary. There are three separate places where you can add a different keyboard input. In two of them I could not add “Thai” but eventually I found the third option.

I appreciate the efforts of everybody who create new distros. This is a beta version, but there are so many “*buntu” versions available and this doesn’t seem to offer anything new. Maybe more effort should be spent on the desktop and replace the Pantheon apps with existing tried and tested applications.
Earlier this month, I was offered the chance to get a copy of Web Development with MongoDB and NodeJS by Jason Krol for review. Since I had previously been experimenting with NodeJS, I jumped at the chance, and worked my way through the book quickly. After finishing the book, I can only say that I am impressed by the quality of the book, as well as the teaching method of the author.

As I’ve already said, this eBook manages to do almost everything right. By the end of the book, you’ll have been led through the entire process of designing and testing a web application using Node.js and MongoDB, as well as having some extra information in the last few chapters. The one problem I ran into was in Chapter 4 (Express.js). The current version of npm (at the time of writing: 2.1.2) did not allow me to install a working version of Express.js 3.5.1, due to changes in dependency packages. Instead, I had to follow the instructions while taking into account the information at the end of chapter 4 (on Express.js version 4). However, this could also count as a plus-point towards the book, for supplying the necessary information in the chapter.

Apart from this one small setback (which, in all honesty, cannot be attributed to the author or the book), the book is written very clearly, and laid out in the way one would approach such a project. The formatting of the book allows the reader to clearly understand what sections of code are relevant to the explanation, and the supplied downloads offer working examples for each chapter (while some changes may be required for the Express.js files). By the end of the book, you should have a good idea of how to approach such a project, as well as having a working application. From there, you should have a good foundation for starting a project of your own design. Even if you’re less interested in NodeJS and more interested in how such a project should be be approached, then this book is an excellent resource and example.

Furthermore, if the book is not enough of a resource for you, it also offers relevant links, and as much extra information as can be included without detracting from the actual material of the book. Along with this abundance of information, the formatting of the book (the pub version at least) offered a very thorough table of contents, and a linked index section at the back of the book. Couple this with the ability to search the ebook, you should be able to find any relevant information as quickly and efficiently as possible.

Even though my main Computer is an Acer C720 Chromebook, I've got a secondary Laptop that normally runs Windows that has been recently running Windows 8.1 Pro alongside the Windows 10 Technical Preview in a dual-boot setup. But today, the Windows 8.1 install has been playing up and I decided to wipe the HDD and start again with either Windows 8.1 only, Windows 10 Technical Preview only, or using the same dual-boot setup.

While backing up my Windows 8.1 Partition (mostly personal files and downloads), I came across the Ubuntu 14.04 LTS .iso that I downloaded ages ago. So, instead of going with a Windows Install, I made an Install DVD for Ubuntu 14.04 to go back to Ubuntu on my secondary Laptop.

The Ubuntu 14.04 Install went as smooth as Ubuntu Installs always go, and it even detected that I was connected to the Internet which hasn't happened for a long time when installing Ubuntu. Once I'd rebooted, I thought I'd burn the Video DVD that was giving me no end of problems in Windows, so I opened up the Brasero CD/DVD burning program and this is where I ran into a few problems.

It seems as though Brasero doesn't come with a couple of dependencies for DVD Video burning installed, and threw up an error when trying to burn the DVD. Brasero requires the mplex (GStreamer Plug-in) and dvdauthor (Application) installed to burn video DVDs. A quick search in the Ubuntu Software Centre didn't find either of the required dependencies, so I tried using the sudo apt-get command in the Terminal - which threw an error as it has been that long since I last used the Terminal to do installs (back when Saucy Salamander was being Developed). I'd forgotten the exact apt command to get and Install a package via the Terminal, probably due to using Chrome OS - the only Linux based OS other than Mac OS that doesn't require much in the way of working in the Terminal (so much so that the Terminal is hidden away in the Chrome OS Developer Mode). I then installed the Synaptic Package Manager and was able to find dvdauthor, but was unable to find mplex.

So I've currently put my venture back into fully using Ubuntu on my secondary Laptop while I either do some full-on digging around in Synaptic Package or the Software Centre or even dig around for the correct apt command to download and install mplex via the Terminal. But, since I needed the DVD burning for Friday 24th October, and another copy for Tuesday 28th of October, I ended up doing the only viable option until I've got the time to sort it out properly, and installed the Windows 10 Technical Preview. But, as I tend to use only my Chromebook, I don't know how long my secondary Laptop will end up with Windows back on it.
MY STORY

I love using Ubuntu and Linux over Windows, but the problems that I’ve encountered after having a long absence from Ubuntu and the full Linux experience, have done only one real thing – which is show me how simple and easy it can be to use Linux – if it’s done in a consumer orientated and consumer friendly way like Google has done with Chrome OS. Windows is ok for people who want something that just works, but is proprietary and prone to viruses; Chrome OS is for people who want something that just works, is Linux based, and who don’t mind living in the Cloud; Mac OS is for people who want something that just works, is more mainstream like Windows along with being a proprietary OS, but also *nix based, whereas Linux based OS’s like Ubuntu are more of a nerdy OS for someone who doesn’t mind getting their hands dirty in the Terminal, and don’t mind spending hours getting things all working. I’m the nerdy type, but since using Chrome OS, I don’t seem to be able to find the time to mess around in forums and in the Terminal trying to find what I need to get something done, then have to spend twice as long troubleshooting why the command didn’t work.

I really love having a free and Open Source OS on my secondary Laptop, but if I can’t get it to do something as simple as burn a DVD video – without the hassle of having to troubleshoot and figure out how to get a missing dependency – then I don’t know if I should go back to Ubuntu any-time soon. It’s ok for now – with Windows on my secondary Laptop until I’ve got the time to figure things out in Ubuntu, or just go for the next best thing when I next have to wipe the slate on my secondary Laptop and start again and dual-boot Ubuntu and Windows, or just attempt a triple boot setup of Windows 10 Technical Preview, Windows 8.1, and Ubuntu.
**Ominous News**

I am running Ubuntu 14.04, and, from time to time, I receive an ominous message that there is a system problem. I am then asked if I would like to report the problem. I always say yes, then the window alerting me of said problem closes.

My question is: what exactly happens when I click yes? Who is alerted? How many people are required to report the same problem before the problem is deemed serious enough for action?

**John Niendorf**

Ronnie says: I asked Alan Pope from Canonical and he graciously replied explaining that all errors go to [http://errors.ubuntu.com/](http://errors.ubuntu.com/) and that you can find your past reports by going to System settings > Security & privacy > Diagnostics > Show previous reports. There’s also a wealth of information on this at [https://wiki.ubuntu.com/ErrorTracker](https://wiki.ubuntu.com/ErrorTracker) with a very informative video (on YouTube) at: [https://www.youtube.com/watch?v=PPQ7k0jRUE4#29m50s](https://www.youtube.com/watch?v=PPQ7k0jRUE4#29m50s)

Many thanks to Alan for clearing that up for us.

---

**Full Circle Podcast Episode 41, Trusted To Fail!!**

Welcome to our new format show, there are several changes from the previous format, the most important being we are now recording together at the Blackpool Makerspace in the office. This Episode we Test Ubuntu 14.04, Review of Official Ubuntu Server Book.

Your hosts:
- Les Pounder
- Tony Hughes
- Oliver Clark

from the Blackpool (UK) LUG
[http://blackpool.lug.org.uk](http://blackpool.lug.org.uk)

---

**Full Circle Needs You!!**

Without reader input Full Circle would be an empty PDF file (which I don’t think many people would find particularly interesting). We are always looking for articles, reviews, anything! Even small things like letters and desktop screens help fill the magazine.

See the article Writing for Full Circle in this issue to read our basic guidelines.

Have a look at the last page of any issue to get the details of where to send your contributions.
Tuxidermy

Yeah, it's just a quiz, I'm doing. What are the real problems about open and free software in modern world?

What does "open" means?

Me don't understands "modern".

You've lost me on the "free" part.

Real? How do you define real?

Sorry, dude. What "problems"?
Q How can I get a later version of Sound Converter than the one in the standard Ubuntu repositories?

A Add the getdeb.net repository. If you go to its website, there are instructions on how to do this.

Getdeb is not all sweetness and light. It is frequently down, which slows down installing updates by several minutes.

Q I’m using Lubuntu 14.04. Does anyone have any help or info on how to run a Powerpoint style program?

A Install LibreOffice. One of its components, Impress, can "play" many Powerpoint presentations, and can generate presentations which can be played in Powerpoint.

Q I used Acronis to make an image of my hard drive, then restored it onto a different, larger drive. Now my drive looks like this:

sda1 246 GB EXT4
sda2 extended partition
sda5 4 GB swap
--- 70 GB of unused space.

How can I use the 70 GB?

A You could use Gparted to create another partition and format it. Launch it with the command: gksudo gparted

Then you could edit fstab so the partition is automatically mounted at logon.

Another approach would be to boot from the installation media, run Gparted, delete the swap and extended partitions, expand sda1 to all but 4 GB of the hard drive, then create a new swap partition.

Please be sure you have good backup before you modify partitions!

Q Eventually there will be an overcrowding on the sidebar. Is there anything I can do to get icons on the desktop?

A Eventually there will be an overcrowding on the sidebar. Is there anything I can do to get icons on the desktop?

Q I installed Ubuntu 14.04 LTS (32-bit). Not sure what format I selected for the hard drive. How can I find out?

A This command will display it: df -T

Q How can I access a shared folder on a remote machine?

A Google "sshfs tutorial" and you will find some step-by-step answers.

Q What package should I use to do some heavy-duty statistical analysis for a PhD thesis?

A (Thanks to monkeybrain20122 in the Ubuntu Forums) Take a look at R.

(Thanks to CantankRus in the Ubuntu Forums) Copy the application launcher from /usr/share/applications to your desktop.
"Categories" and "Sources" in Unity Dash?
http://goo.gl/iAf910

* Can I recover command-line deleted file from trash bin?
http://goo.gl/s6fjKE

* Assembler similar to TASM on Ubuntu?
http://goo.gl/bD7r9C

* Popup ad virus on both Chrome and Firefox
http://goo.gl/cFJcgQ

**TIPS AND TECHNIQUES**

**Resource Allocation Error**

From my perspective, a couple of years ago, Microsoft, the Gnome project and Canonical all galloped off at full speed into the weeds; they each came up with new user interfaces which reduced my productivity.

Since Gnome is, in part, a user interface, it became irrelevant to me. Linux provides lots of choices beyond Ubuntu/Unity, so I regularly use XFCE (Xubuntu) or Cinnamon (Mint), depending on how powerful the computer is.

Perhaps surprisingly, "the community" provided a ready-made fix for Windows 8, in the form of Classic Shell. Other than the user interface, Windows 8 is the most stable Windows yet, so there is a good solution for clients who need to use Quickbooks, Sage and other accounting software.

But Canonical didn’t stop at Unity; it is also working on replacements for other components of Ubuntu, such as Mir. Those might be good things to work on, but I assert that it means they are not putting enough resources into making Ubuntu a solid computing platform. The weekly Ubuntu-News Digest includes bug stats, and not that long ago, the number of Critical bugs was in the nineties; it’s currently over 220.

This affects me. My primary computer does not reliably run any of the Canonical operating systems, beginning with 14.04 and continuing in 14.10. They work for some random number of hours, then lock up. Yet the system is rock solid with Linux Mint 13 and my unusual installation of the 3.13.5-0 kernel. (See FCM#84.) Surely I am not the only one with this type of experience?

So here is my request to Canonical: first fix the bugs, then think about other things.

---

**Gord** had a long career in the computer industry, then retired for several years. More recently, he somehow found himself "The IT Guy" at a 15-person accounting firm in downtown Toronto.
On September 30, 2014, Steam released Borderlands 2 for Linux, two years after its initial release on Windows PC. Having played the original Borderlands, I was kind of excited to find out that its sequel – Borderlands 2 – would be coming to Linux. Like other games I’ve reviewed in the last few months, there was no indication of this game being able to run on PCs with AMD (or Intel) graphics cards, it was supported only for Nvidia. However, once again I decided to read the reviews from AMD owners and almost immediately I felt comfort in finding that the game was running pretty well with AMD graphics cards. So, I decided to give it a try and play it. So far, so good.

Borderlands 2 is an action, first-person shooter game, developed by Gearbox Software, published by 2K Games, and ported to Linux by Aspyr Media. The timing of the Borderlands 2 release for Linux couldn’t have been more perfectly planned, as ‘Borderlands: The Pre-Sequel’ was released a mere two weeks later for Microsoft Windows, OS X, Playstation 3, Xbox 360, and Linux. The Pre-Sequel serves as a sequel to the original Borderlands, but also a Prequel to Borderlands 2, so basically somewhere in between. If this sounds confusing to you, don’t worry, it is confusing to most of us.

Borderlands 2 can be played with a mouse/keyboard as well as with a game controller. No matter what input device(s) you use to play the game, the game-play mechanics are pretty much the same as most first-person shooters. You walk, run, duck, jump, shoot, etc, just like you would in most other FPS games, but you can also perform your character’s special moves. In fact, I made a lot of progress without the need for a tutorial before I found out about the special moves – because of how similar this game is to other first-person shooters.

What sets Borderlands 2 apart from other FPS games lies in the presentation and in its comedy. The artwork is a sort of hybrid cartoon/realistic style. Ever since the original Borderlands game, the developers decided to go with what they call ‘cell shading graphics’ which is what differentiates the game from other FPS games that might look more realistic. The comic, cartoonist effect actually fits well with the direction the Borderlands series has taken. Not only that, but it also completely sets it apart from other games from the same genre. The comedy is not only outrageous, but also very often just plain old crazy, off-the-wall humor that leaves you wondering who in their right mind thought about these things.

Borderlands 2 can be played in one-player campaign mode, or there’s also the option to do a multi-player mode where you have the possibility for up to a four-player co-op. With that said, you’ve got four players, or Vault Hunters, to choose from. Each Vault Hunter comes with his (her) own playing style, abilities and special moves. The game takes place in the planet of Pandora, where you must find a series of vaults – before Handsome Jack (the villain) finds them to carry out his evil plans. Leading the way and guiding you as you progress on your quest is a robot by the name of CL4P-TP (ClapTrap), who kind-of reminds me of a loopy R2D2. The little fellow does have a few redeeming traits, like helping you in opening many doors & gates, or getting past other odd characters who otherwise wouldn’t let you through. Anyone who’s played the original Borderlands will definitely remember ClapTrap, as well as
many returning characters. Although there may be many familiar faces from the original game, there are also as many, if not more, new characters introduced in this game. The story takes many twists and turns along the way, but it keeps you engaged as you progress in the desolate planet of Pandora. It’s a well made game that keeps the player entertained.

To play Borderlands 2, it’s imperative that you have a Steam account. If you don’t have one, you’ll have to get one. Through Steam, you can currently get the game for $19.99, or be on the lookout for a special deal from other sources, though once you purchase it, you’ll have to open a Steam account.

CONCLUSION

I’ve encountered very few and minor glitches in Borderlands 2 since I began playing it. I had my doubts as to whether I’d be able to play this game with my AMD Radeon HD 5770 graphics card because the minimum requirements list only Nvidia graphics cards, but I can testify that AMD cards work just fine.

Other than the occasional and very rare 2-3 second delay that I’ve so far encountered only twice, there have been no other problems with the actual game. The real bug I’ve come across is when I take screen shots. The screen-shot itself will look perfect, but the left side will always be elongated thus making the screen-shot seem longer than it really is. I’ve taken the time to clean up the screen-shots for this article simply by cropping the part I need. It’s a very minor detail since it’s not something you’ll encounter while playing the game, and I believe it’s experienced only by AMD graphics cards so it’s almost a non-issue.

I am not a big fan of first-person shooters, but this game is on a category of its own, and it has been very enjoyable to play. I definitely do recommend this game whether you like the FPS genre or not. Maybe it’s the way it looks; instead of going for the realistic look, it opted to go for the cell-shading cartoon look. Maybe it’s the humor, because it has quite a bit of it, and some of it is outrageous. Or maybe it’s just a great game, like many critics have said.

I give the game 4 out of 5 stars because of AMD cards not being fully supported yet.

MY GAMING SETUP

I played Borderlands 2 with my custom-made desktop PC consisting of an AMD FX-6100 3.3GHz CPU (over-clocked to 3.5GHz), an Asus M5A97-EVO motherboard, a Sapphire Radeon HD 5770 graphics card, 8GB of Kingston Hyper X RAM, and a 1TB Seagate Barracuda hard drive. The software used was Ubuntu 14.04.1 LTS with Unity desktop and AMD 13.9 proprietary graphic drivers.

Minimum System Requirements:
OPERATING SYSTEM: SteamOS, Ubuntu 14.04
CPU PROCESSOR: Intel Core 2 Quad, AMD Phenom II X4
CPU SPEED: 2.4GHz
MEMORY: 4 GB RAM
HARD DISK SPACE: 13 GB
VIDEO CARD (NVIDIA): Geforce 260
VIDEO MEMORY (VRAM): 1GB

Oscar graduated from CSUN, is a Music Director/Teacher, beta tester, Wikipedia editor, and Ubuntu Forums contributor. You can contact him via: www.gplus.to/7bluehand or email: www.7bluehand@gmail.com
I've really changed this over the last few months. Here's some info to post in "My Desktop" if you like:

- HP TouchSmart Core Duo P7450 (2.13GHz), 4GB DDR3 RAM, 1.5TB HDD, 23" Touchscreen Desktop PC
- Ubuntu 14.04
- Unity (of course!)

Screenlets 0.1.6 take care of displaying info, with few resources
- Cairo - Dock
- Wallch Wallpaper Changer
- Use desktop thumbnails for a "Photo album" of people important to me

I really use the Unity launcher to start 90% of my apps, etc. The dock is an extra place I will sometimes look as it displays any program running. I started late in Linux, at age 45. Interesting to note, my PC is also used occasionally by a man aged 68 years, a testament to the fact that Ubuntu is becoming more and more popular.

Brian Bogdan
MY DESKTOP

- OS: Kubuntu 14.04LTS
- PC Specs: Intel Dual CPU @ 1.8GHz and 2GB RAM

I love Kubuntu. It’s customisable and has all the original compiz features that first drew me to GNU/Linux.

Desktop Cube: Cylinder

Christo A Van Wyk

full circle magazine #91
FULL CIRCLE NEEDS YOU!
A magazine isn’t a magazine without articles and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker

Full Circle Team
Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert Orsino, Josh Hertel, Bert Jerred, Jim Dyer and Emily Gonyer

Our thanks go to Canonical, the many translation teams around the world and Thorsten Wilms for the FCM logo.